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Introduction
TM

XPowder is a widely used program (Figures 1 and 2) that was created for the operating system Windows , to
facilitate the analysis of Powder X-ray diffraction patterns.
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Figure 1. Number of downloads of the program XPowder from www.xpowder.com between January and
JAPAN
September 2008 . The data are from ‘Advanced Web Statistics 6.6’ (build
1887) - Created by AWStats (GNU
General Public License) and do not include downloads from unknown or repeated IP addresses.
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Figure 2. Geographic distribution in % of downloads of the program XPowder in the first half of October 2008,
SAUDI ARABIA
which corresponds to the start of the academic year 2008-2009.

This program recognizes files from most diffractometers, and handles a number of simple ASCII formats that can
easily be generated for import. XPowder also lets you acquire data directly from some older diffractometers
who did not have proper digital control for Windows operating system. Automatic sample-changer and
monitoring of temperatures, are also handled by XPowder.
Files may contain data in the form of a list of intensities (counts, cps, absolute or relative intensities, etc.) from an
initial angle 2, and constant º step in a txt formats.
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XPowder can also read 2D images (jpg, tiff, bmp, mccd, etc) obtained by instruments with CCD detectors and
directly calculate their powder diffractograms.

Recognition of data formats.
* RAW
* X’Pert
* RD
* UDF
* CCD
* Ascii
* POW
* GSAS
* DBWS
* DAT
* UXD
* GRF
* Xye
* Sietronic cpi
* Seifer nja
* Etc.

Binary. Siemens – Bruker diffractometers (1 to 4 versions)
Html. Philips diffractometers
Binary. Philips diffractometers
ASCII. Philips diffractometers
All type of file images: jpg, bmp, etc. TERRA Diffractometers have a specific modulus.
2 [separator] Intensity (.txt, .asc, .xy)

Several kinds
Cerius program calculated diffractograms
Mercury program calculated diffractograms

The program will recognize additional file formats in future versions. Please contact the author to request the inclusion of any specific
format.

The conversion of any data file into one of the formats recognizable by XPowder is usually straight forward:
PLV, the native format of XPowder (P,L and V are the consonants in polvo -powder in Spanish) is an ASCII
text format with a very simple configuration containing the following information:
* First line: Information about the specimen.
* Second line: Starting 2 angle at the beginning of the experiment.
* Third line: 2 step between successive intensity measurements.
* Fourth line: K1 wavelength in Å. The precision of the value in this line is not important since
XPowder normalizes all the K1, K2 and K values according to the content of ‘xpowder.ini’ file.
* Fifth line to end: Experimental diffracted intensities (one per line).
An example of PLV file is given below:
RENDIJA=AUTOMATICA. CALCITA. Intensidad máxima:
3.00
0.06
1.54051
1
3
7
···

10732.
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Other richer PLV formats (versions 2 and 3) contain additional information about the experimental conditions.
The example below shows a PLV version 3 file.
XPowder diffraction software. PLV file format Ver. 3.0
Sample= Fluorita0.PLV
Site= Universidad de Granada (Spain)
User= Crista-Mine-Gr
Date= 18/06/2004
Time= 13:32:38
Start 2-theta scan= 3.000
End 2-theta scan= 80.000
Step size= 0.040
Scan mode= Continuous
Integration time(sec)= 0.4
Anode= Cu
Filter= None
Monochromator= Graphite 2º
K-Alpha 1= 1.54051
K-Alpha 2= 1.54433
Ka2/Ka1 Ratio= 0.5
K-Beta= 1.39217
Automatic sampler changer= NO
Single Gobel mirror= NO
Divergence slit= AUTOMATIC
Receiving slit= 1/0.1/1
Generator voltage(Kv)= 40.00
Tube currrent(mA)= 40.00
Maximun counts= 5194
Line
26
Line
27
Line
28
Line
29
Line
30
Line
31
Line
32
Temperature = 22
Line
34
Line
35
Line
36
Line
37
Line
38
Line
39
Line
40
Line
41
Line
42
Line
43
Line
44
Line
45
Line
46
Line
47
Line
48
Line
49
Data
3.000
22
3.040
20
3.080
19
3.120
15
3.160
16
3.200
21
3.240
20

This file type uses' keywords' (Start 2-theta scan for example) followed by the sign '=' and the value of each
argument (= 3.000). The lines that contain the keyword 'Line' are ignored by the program. From the keyword
'Data' are tabulated values of '2' and 'intensities’. It can contain any number of lines of header and the order is
irrelevant, except that the first line should contain the key 'PLV file format View. 3.0' or ' View PLV file format. 2.0
'. Version 2.0 is equal to 3.0 except that the data list can only contain intensity values (no 2 angle).
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What can you do XPowder?.
The main operations, as described in the following five points, are made by pressing buttons or selecting from
pull-down or contextual menus. The latter appear when right-clicking the mouse on the graphic or object of
interest:

1. Identification of crystalline compounds (Search-Match). It is necessary to have a database, such as'
PDF2.DAT 'of the ICDD (International Center for Diffraction Data) and, or, the' Difdata.txt 'of AMSCD.
The latter only contains minerals.
The phase identification of samples with one, two or three major components is usually done with a
single 'Click'. With more complex samples, either with more phases or minor components, the complete
identification is achieved easily by using various tools such as subtraction of patterns already identified.
All these tools are detailed in Chapters 2, 4 and 5.
2. Quantification of compounds. The quantification is done on full profile of the experimental diffractogram
by non-linear least squares regression based on parameters such as 2 displacement and profile
function (Gauss, Cauchy, Pseudo Voigt, Pearson VII and asymmetry). All calculations are accompanied
by statistics. The reference data for each phase can either be full patterns (experimental or calculated)
or database records (positions and relative intensities). When using a 2θ/Ir database, a Reference
Intensity Ratio (RIR) must be used for each phase, and can manually entered if not provided in the
database, or if particular experimental conditions require their adjustment. The calculation takes into
account the absorption correction based on the chemical composition provided by the database. It also
takes into account a parameter that represents an approximate percentage of amorphous phase in the
sample. The program is designed to automatically carry out up to fifty simultaneous quantitative
analyses. The results are presented in tabular form within the 'log file' of each session. The
quantification of compounds is detailed in chapters 6 and 7.
3. Crystal size, 'strain', thermal expansion tensor. Tools are provided for crystal sizes and 'strain'
calculations using the 'Williamson-Hall' and 'Warren-Averbach' methods, in addition to the classic
'Scherrer' method. A specific tool allows calculating 'log-normal' distribution in very low crystallinity
materials. This is detailed in Chapter 10. If the diffractogram records are made with temperature control,
the thermal tensor can also be calculated (Figure 8.9).
4. Assorted tools.
a. Automatic unit-cell refinement of identified phases (Chapter 9).
b. ”K stripping” by a highly optimized Rachinger method.
c. Automatic background subtraction. Smoothing (elimination of excessive vibrations and noise) by
Fourier transform and functional filters.
d. Calculation of powder diffractogram from electron or X-ray diffraction 2D images.
e. Calculation of the diffractometer instrumental profile.
f. Calculation of the Caglioti equation for real samples (Chapter 11).
g. Calculation function of profiles and theoretical mixing patterns.
h. Addition and subtraction of diffractograms.
i. 2 offset correction using standard pattern or harmonic peaks (Chapter 3).
j. Logarithmic/Arithmetic scaling.
k. Calculation of reciprocal histograms.
l. Reporting text ('log file').

5.

Graphic tools.
a. Zoom.
b. Choice of color palette and active diffractogram.
c. Copy and paste images.
d. Generation of graphics (bitmaps) and vectorial (hpgl) files.
e. Dynamic 3-D representation of up to fifty patterns.
f. 2D representation of diffractogram series (diffraction maps) with calculation of curves and level,
or false color very useful for studies of phase changes and crystallinity (Chapter 8).

XPowder Installation
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A single installation file (' xpowder_setup.exe ') is used for all program options (Trials, Academic, Professional,
PLUS, etc.). It is available from www.xpowder.com (download) and can be freely copied or distributed.
Instructions:
1. Download the latest file version (2004.04.xx) of xpowder_setup.exe from www.xpowder.com
2. Double click on then XPowder_setup.exe installation icon.
3. Follow the instructions that will appear on the screen (figure 3).
4. If you have the license code of the program, insert it (preferable copy/paste) into the box
Main menu -> Help -> XPowder registration code
Please, backup this registration code because it is valid for future installations and/or updates. The XPowder
program will be licensed and may be updated without having to re-input the code (this code is recorded in the
text file 'Folder program / Code.txt’). If this file is deleted, the program will behave as a 'trial version' valid for 20
days, for analysis of up to 500 diffractograms.

Figure 3
Database installation
The databases are not attached to the program and must be purchased separately. The databases recognized
by XPowder 'PDF2.DAT' (between 500MB and 550MB or so, depending on the version) and 'DifData.txt'
(approximately 65 MB). You can install both in parallel from the main menu:
Database-> Database install (or Database Update)
Select database file and then pulse Install (figure 4).
Database files could be:
 ICDD:
‘PDF2.dat’
 AMCSD:
‘cifdata.txt’ (optional) + ‘difdata.txt’ (required). In any case, ‘cifdata.txt’ must be
installed before the 'DifData.txt'. 'cifdata.txt' (approximately 31 MB) is an auxiliary file of
'difdata.txt', its use is optional and it can be deleted once the setup has been completed.
It is desirable that the databases are on your hard drive rather than on a CD-ROM or DVD in order to optimize
the searching speed.
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Figure 4

PDF2.DAT. It is the most popular database and is sold by the ICDD. For installation in XPowder only need the
file 'PDF2.DAT', because XPowder creates its own index. PDF2 contains several sub-files that include all
branches of solid materials used in science and technology:
Inorganics
Organics
Minerals
Metal and allows
Common phases
NBS (National Bureau Standars)
Forensic
Educational
Zeolites
Explosives

Super conducting materials
Cements
Corrosive materials
Polymers
Detergents
Pigments
Pharmaceutical
ICSD
Ceramics

PDF2 can be purchased at:
ICDD Internet site:
Postal Address:

Telephone

www.icdd.com
E-mail:
International Centre for Diffraction Data
12 Campus Boulevard
Newtown Square, PA 19073-3273 U.S.A.
(610) 325 9814
(610) 325 9814
(General information)
(610) 325 9810
(Sales)

info@icdd.com

The quality of the PDF2 records is very heterogeneous, since there are diffractograms obtained
with different radiation, different geometries or instrumental conditions. There are even not
indexed or wrongly indexed phases. They also contain theoretical diagrams calculated from
their crystal structures. In general the quality of the records is good and the file is completed
and improved year after year.
In order to install the ICDD database, only ‘PDF2.DAT’ file from PDF-CDROM is necessary
without any other file index.

DifData.txt. AMSCD database (American Mineralogist Crystal Structure Database) a free
database created and managed by Dr Robert T. Downs of University of Arizona. It is limited to
minerals. Diffractograms were calculated from the crystal structures published in the scientific
literature. In general the quality is high and the database includes many entries of isomorphic
series at high temperatures and high and very high pressures.
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To obtain this database, contact:
Dr. Robert T Downss.
email: downs@geo.arizona.edu
phone: 520-621-4938
or by post:
Bob Downs
Dept of Geosciences
University of Arizona
1040 E 4th, Tucson, AZ, USA.
85721-0077
http://rruff.geo.arizona.edu/rruff/

The records have a homogeneous quality and, although these are calculated, fit well with
experimental diffractograms. The biggest errors occur in minerals whose structure and unit-cell
were published long ago, as they were based on values of inadequate wavelength or inaccurate
tools. This results in systematic errors on calculated d-spacings and hinders the identification.
By contrast, diffractograms based structures published in the last few decades are very
accurate. The Difdata.txt file does not include chemical formulas in itself (it only indicate the
name of a mineral). However, the composition is found in the 'CifData.txt' file provided in parallel
and can be loaded prior to difdata.txt installation. Even without this operation, XPowder assigns
a chemical formula to correct 96% of the records. Another handicap of this database is the lack
of the ‘I / Icor’ parameter, so XPowder automatically and temporarily assigned a value of 1 to
RIR parameter for quantitative analysis.
CifData.txt. is a complementary AMSCD database (American Mineralogist Crystal Structure Database) . It contains the
structural and compositional data that have helped generate sheets of diffractograms database 'DifData.txt'. The
installation under the program XPowder is not necessary (but desirable). In any case must be installed before the
'DifData.txt'.

P2D2 (Predicted Powder Diffraction Database) is built up by calculating the powder patterns
corresponding to the predicted crystal structures from the latest PCOD update. The job is done
partly by ZEFSA II (898707 entries) and for the GRINSP data (163520 entries) by the CIF2POW
software. The P2D2 database currently includes twelve text files, each with approximately
100000 compounds, which can be automatically indexed by XPowder12, individual or jointly.
MyDatabase.MyD. It is a database that can easily be created and customized by the user, as
shown in Chapter 5.
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Chapter 1. The main screen
The image of the figure 1.1. appears when you run XPowder.
At the top are provided a drop-down menu (File Edit ...) and tool bar with buttons that perform
the main functions of the program.
Under the tool bar is provided the main graph area.
In the middle of the window (blue background) are shown various options and default values
(data file, 2 limits, database options in the main chart, etc.).
At the bottom (orange background) is a second graph area

Figure 1.1. XPowder home screen.
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How do you open a file?
From the main menu (File -> Open file or pressing the second button

(figure 1.2.)

Figure 1. 2.
You can select one or more file samples (A.plv ... D.plv in this example). After clicking OK ,
you get the figure 1.3.

Figure 1.3. Main screen
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Main commands.
Once the files are loaded, a diffractogram is shown in both the upper and lower graphs, while
they are activated menu options and some buttons that until now were disabled. On the 'Zoom'
screen is drawn in detail the diffractogram in position near the cursor. The cursor consists of two
lines when the box Kalpha 1-2 pointer is marked: The red mark the position K and the green
K. In the File box have been deployed all four files are loaded. You can select any of them
with the left mouse button.
The lower graph shows the entire diffractogram and allows zooming using a ‘click&drag’ of the
mouse. The region of interest is then displayed on the upper graph (for example 49<º<56 in
the example of figure 1.4). To zoom directly in the upper graph, the Shift key must be pressed
during a left click & drag of the mouse.
On the main graph, a left click of the mouse button adds a peak position that will be taken into
account in subsequent calculations (the program can also find peaks automatically).

Figure 1.4.
To restore the full-size diffractogram, click on the button
by right-clicking the mouse, as in Figure 1.5.

or use the contextual menu appears

Figure 1.5.
The button

can also be used for zooming out.

In a similar way many routine tasks can be performed within this graph.
For example:
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Activate the cursor to display the position of K

, and K

.

Also to display simultaneously several Bragg’s orders


Select or change the active database at any time.



Enter the lower and upper 2limits.



Show the values of the d-spacing
and positions of the peaks
main graphic, where they have been previously calculated.



Show HKL indices of the components previously identified



Correct the position of zero angle .



Calculate the average intensity of a diagram and its standard deviation (useful for
estimating the 'crystallinity' overall sample in a simple way) .



Identify with one click crystal components in the database with the active restrictions

in the

in the main graphic.

(chemical composition, subfiles, pressure, temperature, etc.).


Advanced identification of crystalline compounds through restriction of chemical
composition, observation window, Euclidean criteria, Boolean criteria, etc.
(Chapters 2 and 4).



Set the chemical and subfiles searching conditions.



Display peak positions and intensities of the phase highlighted in the search result
window



Display peaks positions and intensities of all mineral selected in the search result
window.



Strip K



Subtract the background.



Smooth the data using Fourier transform smoothing
(Chapter 3).



Crop the 2 interval of the main graph
from the computer memory.



Calculate the average intensity and standard deviation of full intensities



Refine the unit cell without operator intervention

(Chapter4).

(Chapter 3).
(Chapter 3).
or functional smoothing

.

. This action removes the rest of diffractogram
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.



Show the results of quantitative analysis and differences on the main screen.



Save difference diffractogram with text PLV format.



Acquire data from diffractometer (PLUS version only).



Calculate
or clear
the values of d-spacings of full diffractogram. You can also
add a peak with a left click or remove a peak by double clicking on it.



Calculate



2 zero shift correction by standard patterns or harmonic reflections methods
(Chapter 3).



Profile calculations, which include determining the Caglioti function for the sample (or
instrument profile), quantitative analysis from the database, depending on the

or clear

only the values of d-spacings of main screen selected zone.

calculation of mixing, Williamson-Hall plot, and so on.



(Chapters 10 and 11).

Estimates of domain size and strain by means of Warren-Averbach methods.
Calculating log-normal distribution. It is possible to apply automatically instrumental
correcting by using a very crystalline standard or by calculation on the basis of the
Caglioti and profile functions.

(Chapter 10).



Select active diffractogram color.



Palette for diffractogram series.



Select wavelength values.



Interpolate experimental data using cubic splines that do not alter the shape of the
profiles. It is useful in analyzing profile, unit-cell refinement, etc.

(Chapter 3).



Refine Unit-cell refinement.
This option is best done when the samples have been
previously identified and also the component K has been eliminated.



Show pattern series in 2D and 3D



Refresh screen, unload, reload and restore previous search data of actual diffraction
pattern, with the
buttons respectively.



Reverse or eliminate negative intensities, reverse values, respectively
are useful for manipulating calculated or differences diffractograms.



Open files, print graphics and reports, save files, exit program
respectively.



Database install or update.



Añadir una nueva ficha a ‘Mydatabase.MyD’

(Chapter 8).
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. These



Occasionally undo the last change

Small horizontal bars that appear on some command buttons perform the same operations as
these, but above all the loaded diffractograms

Menu bar. Is at the top of the screen. It performs many of the button actions described in the
preceding paragraph. Most actions can be selected using either method.

Clicking on any entry in this bar, opens a scroll-down menu:

File

New: Start session.
Open: Load a diffractogram file.
Acquire: Load data from diffractometer (only PLUS version).
Print: Print graphics and scripts..
Save changes: Save changes of diffractogram data.
Save changes as...: Save changes a diffractogram data with a different file name.
Save graphic: Save BMP image of active graphic with the computer screen resolution.
Export graphic as HPGL. Create and save a HPGL (plotter file) that can be exported from some graphics programs like
Corel Draw.
Save Log File as TXT. Create a text file that contains an echo of the calculations made and the results,
Unload. Download the actual diffractogram of the computer's memory.
My favorite compounds: To retrieve results of prior qualitative analysis (. RES for the PDF2 database and .RUF for the
AMSCD database)
Exit: closes the application

Edit

Undo Ctrl.+Z: Undo last change
Copy Ctrl.+C: Copy the diffractogram graphic on the clipboard.
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Tools

XPowder format-file associations: Allows associate files with extensions of the program XPowder so they can be
opened automatically when you double-click on them in Windows Explorer or the desktop.
Graphic output: It sets up the options and features to be included in graphics printouts.
Profile parameters: Shows the parameters of the profiles of the reflections, both the active as the profile of the
instrumental diffractometer. The values can be changed, but are not calculated from this option (for this we must use the
button
(Chapters 10 and 11).
Diffractogram color: Set de active diffractogram color.
HKL parallel to atoms: Calculates the indices HKL of a face parallel to two structural or morphological addresses.
Thermal dilation: Calculates the thermal expansion coefficients if diffractograms are obtained at different temperatures.
This tool operates automatically on the screen 2D, when used thermodiffraction.
Wavelength: Set wavelength values
Merge: Graphically sum or subtraction of diffraction patterns.
Adding all patterns: Calculate the average diffractogram of all loaded pattterns.

Action

division by sin(theta): Can simulate a change from fixed to automatic slit.
multiply by sin(theta): Can simulate a change from automatic to fixed slit.
División by Lorentz-Polarization: Performs Lorentz-polarization factor correction of powder diffractograms. It is useful in
profile analysis.
Multiply by Lorentz-Polarization: Reverse of the previous operation.
Change automatic slit to fixed slit. Simulates the change from automatic to fixed slit in Bragg-Brentano geometry. The
used function is :If = º· 0.20268·Ia/sin(11.16+º·0.88-0.19)
(If = Intensity measured with fixed slit, Ia= Idem automatic slit, º = divergence fixed slit).
Change fixed slit to automatic slit: Reverse of the previous operation.
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Logarthmic/Aritmetic: Puts the intensities axe in logarithmic/arithmetic scale. Its use is highly recommended to localize
reflections of low intensity, on very low crystallinity materials or having a great orientation. Use the arithmetic scale for
qualitative and quantitative analyses. Do not carry out operations such as' Ka2 stripping, subtraction of database profile
cards, etc,. when using the logarithmic scale.
Strain and Size: Profile analysis general tools.
Smoothing: Removes noise through functional and Fourier transform filters.
Peak search: Search maxima of Bragg reflections
Unselect all peaks: Unselect Bragg reflections.
Data cubic interpolation: Make a spline cubic not distorting, which allows interpolate experimental data without changing
the shape of the profiles. It is a very useful filter.
Background subtraction: Perform background subtraction automatically.
2-theta offset: Tool for the correction of zero on the scale of 2, using internal standards or harmonics.
K-Alpha 2 stripping: The component K of diffractograms obtained with X-ray tube is removed. It is necessary for many
calculations profile based on widths of reflections and highly advisable before unit-cell refinement.
Unit cell refinement: Automatic unit-cell refinement.
Miscellaneous: Profile calculations, which include the Caglioti function fitting for the sample (or instrument profile),
quantitative analysis from the database, depending on the calculation of mixing, Williamson-Hall plot, and so on.
(Chapters 10 and 11).

Database

Database Boolean searchig: Allows a manual search of records from the database by 'Set-File', key words, names,
chemical composition, and so on. This example shows how to search apatite containing fluorine and carbonate anions
in the base PDF2 with the options active ( ) which are explained in
Chapter 4. If the PDF2 set and file '5 586 ' are introduced in the box
Set File (or nickname)
, the program will return the record of the
mineral calcite. If this box is introduced any nickname, described in the file
'Favorites.txt', or part of it, the program will return the record with the same
nickname (Chapter 12).

Advanced searching: Advanced identification of crystalline compounds through restriction of chemical composition,
observation window, Euclidean criteria, Boolean criteria, etc. (Chapters 2 and 4).
One click searching: Identify with one click crystal components in the database with the active restrictions (chemical
composition, subfiles, pressure, temperature, etc.).
Database options: Set the chemical and subfiles searching conditions. (Chapter 4).
Database install (or Database Update): Allows you to install (or reinstall) a database (PDF2.DAT or DifData.txt).

Home

22

Chapter 2. Searching advanced options
This section (Figure 2.1.) is accessed from the main screen(Figure 1.3.) by clicking on the
button

.

Figure 2.1.
The graph of this screen shows the diffractogram with the zoom level used in the main screen.
You can get a greater detail by pressing the Shift key and dragging with the left mouse button
on the chosen area. The button
rescale the diffractogram to full size, while the button
diminish the scale gradually.
When you move the cursor on the graphic the values 2, spacing and intensity show
respectively in the three boxes (back yellow , green numbers) are located above the key
.
The sky blue area of the bottom of diffractogram 'hidden' reflections of lesser intensity. The
optimum height is calculated by the program itself. The peaks hidden will be taken into account
during the search but as an incidental, so that components minority might go unnoticed in these
conditions. The height of the blue zone can be changed by clicking on the desired height with
the left mouse button. The value of cut is reflected in the box Intensity cut. The sky blue area
can be overridden by pressing the button
, or restored to its original value with
. It
is convenient to use the blue zone during the early stages of identification in samples with many
components. In later stages, and without it you can establish the components minority.
When you check the box
, you can select the first N letters of the name of a
crystalline phase, so that the program will choose the best card in the database for that chain
letters. In the example, assume that the sample contains the mineral 'Celestine', which is ten or
more records in the PDF database, and five in the AMSCD database, will show only the best
suited and whose name begins with the string 'Celes' (5 characters). The program distinguishes
between phases removed from the database (Deleted in PDF2) of the active. Thus, identifying
where the criterion be applied Skip duplicates show results as possible 'Celestine' and 'D
Celestine' in the example above. The first letter D is used to mark the card as deleted. If during
the search you want to discard the deleted records see Chapter 4.
Within the framework of search parameters Searching parameters you can select the interval
2-theta gap that the program used to consider as a reflection observed.
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This value corresponds to the width (2q th) of the distance between the two vertical green lines
in Figure 2.1. It is appropriate that this value is given to excess. Very small values may prevent
some compounds are not 'observed,' what happens when diffractometers are poorly aligned or
records from the database are of low quality. The default value (0.20) is usually valid for the
majority of cases.
On this screen you can select the active database (PDF2 o AMSCD).
The order
allows you to select specific subfiless within each database (minerals, organic
compounds, and so on, inside PDF2, or PT conditions within AMSCD) and chemical restraints
(for example, you can search for Fe, Mg or Ca carbonates). The use of this tool is shown in
Chapter 3. The restrictions were activated show next to this icon (looking for... en la Figure
4.1.).
Matching criteria box lets you select between four criteria for identifying phases. All of them are
based on numerical taxonomy methods in a multidimensional space where, the minimum Euclid
hyperdistances (H) between the data of problem diffractogram (Mo) and of the database (Mc)
are calculated. The differences between the methods lies in the different ways in which defines
the axis of multidimensional space:

H2 = ∑ (Mo-Mc)2
To find H, you must use only reflections inside the 2 selected interval. Therefore, the zoom
should not be used to analyze the complete diffractogram in searching procedures. The zoom
should be used only when you want to identify reflections and isolated minority phases.


FOM . The axes contain 'figures-of-merit' dependents of 2-zero error of diffractogram.
Should not be used when the diffractomet is badly aligned or the database records are
poor quality.



Magic . The axes contain 'figures-of-merit' independents of error of zero difractometer,
the database and the coincidence of reflections from various crystalline phases. Often
the most effective approach for identification.



Classic .The axes contains d-spacing values, although XPowder automatically corrects
the corresponding values of the databases, agree to normalized experimental
conditions, before proceeding to the calculation of hyperdistances. This criterion should
not be used this approach when there are many similarities between 2 angles of
different components, the difractometer is poorly aligned or database records are of
poor quality.



Desperate. The program uses only two reflections of experimental diagram and
optimizes its agreement with the database. Should be used only in diffractograms of
very low quality or for minor phases. The second option approach 'Desperate' is not
affordable by the user, but is selected exclusively by the program itself in cases that do
not appear obvious solutions or when you have selected a single reflection of the
experimental diagram.



2 reflections. Since version 2004.04.54 has been including a new approach that uses
only two of the diffractogram reflections to maching with the high intensity reflections of
database records. When this option is used, the number of possible solutions is high in
general, due to the lack of information used in the calculations. It is therefore
appropriate to provide supplementary information to the program (about chemical
composition, for example). This approach should be used in diffractograms having
small scaning intervals (eg 2 <2 <50 ° ), or for identication of minority phases. Also,
from version 2004.04.54, the second searching options of 'Desperate' has been
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renamed to '1 reflection' , because it uses in searching one selected reflection only.
(See updates).
The hyperdistance value (H) is considered by the program as a key criterion for the
identification and its value appears in the output table (‘Matching’ tool, Chapter 5).

The search begins when you press the button
. Alternatively you can complete the list
of subsequent phases identified with the button
. The button
does the
program go back to the initial screen without performing any search.
The ability of this program to search for and identify compounds is high because of their special
characteristics:





The algorithm that uses the approach Magic improves, more than any other, both the
quality of experimental data as those from the databases.
During the search process (searching), XPowder standardizes the value of the
wavelength. To do so reads the value of radiation used in each database record and
correcting the position of maximum for the radiation used in the diffractogram problem,
regardless of d-spacings write in the database. The process takes place even if the
discrepancies in values of wavelengths are minimal. For example, some records have
been obtained with wavelength Kaverage, while others have been developed with K or
even with other radiation differently. This does not affect the algorithm for calculating
used by XPowder, but the criteria used by other searching programs.
After obtaining the best match by calculating hyperdistances, a second approach is
performed. Then, each database records is adjusted to the experimental by nonlinear
least-square methods. The their possible misalignments of 2 are refined again. The
standard deviation obtained during the procedure allows to specify the phase, within the
list of substances identified by the calculation of H. Furthermore, adjusting the fractions
(f) of the mixing function (F) of each component (c) for each angle , so that:

F = (∑ Ic · fc ) / ∑ fc

Ic are the intensities of each component in the angle . Therefore, allow fc values
estimated preliminary weighting of each component between 0 and 1 (see Figure 5.2:
fc= Weight=0.75 corresponds to the weight of celestine in the global mix function).
These operations, unlike those used in the calculation of H, are made on the whole
diffractogram, whatever the used zoom.


The results are displayed in a single list (Chapter 4) that can interact graphically
(matching) with the experimental diffractogram. Optionally, you can subtract gradually
phases identified in the original diffractogram (see Chapter 5. Card profile , Figure
5.7). This, which is not normally required, can occasionally facilitate the identification of
minority components. On the other hand, can be superimposed graphically diagram
experimental records from this list, one at a time, or all considered correctly identified.

Home
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Chapter 3. Pattern filtering

In general there is no need to make any special treatment from the diffraction data, but when
the experimental conditions are not ideal, some tools can be used to improve quality.
1. Zero 2 offset angle correction.
(See also update 2010.01.10: Planar CCD geometry,

Polynomial 2 fit)

XPowder has two methods to to correct the error of 2zero:


Correction with internal standard.

Figure 3.1
In Figure 3.1. an internal standard, which can be selected from the list of the frame Standard
(Quartz low (2) in the example), is used to verify experimentally the displacement of 2. The
internal standards can be included in the file manually 'std.txt' as described in chapter 12.
You can 'zoom' on the area 20<<30 for more precisisón (Figure 3.2).

Figure 3.2.
With the tool
can move the diffractogram its true position (Figure 3.3) and shows the
movement made (-0.0480) in the framework Zero shift .
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Figure 3.3


Correction  through harmonics.

To apply this method will require two different orders of a reflection, that appear on the angles
 and  respectively.
When there is a shift of the origin  of the scale of the angle , the equation of Bragg requires:
n1·  = 2 d sin(1-)
n2·  = 2 d sin(-)
N = n1/n2 = sin(1-) / sin(-)
N = (sin .cos- cos .sin(sin .cos- cos .sin
If numerator and denominator are divided by cos()
N = (sin - cos · tan(sin - cos · tan
tan(sin - N sin ) / (cos - N cos

it appears the error of angle 




To carry out the correction, you should select two orders of a reflection of Bragg (could be any,
even non-consecutive reflections) within the frame Zero shift reflection pair method. In Figure
3.4, have been selected respectively orders 1 and 2 (you'll see the cursor corresponding graphs
from n = 1 to 2). By placing the cursor n = 1 on the first reflection (approximately 18.6 degrees)
shows that the position of second order is not correct (the second cursor, approximately 17.7
degrees). Pressing Alt + left mouse button is a utomatically carries out the correction, as
shown in Figure 3.5.
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Figure 3.4. Before correction of zero 2.

Figure 3. 5. Has been detected and corrected a displacement of -0.0800 º. The correct positions
of the two reflection orders are marked with their respective values of n.

In either of the two methods described, when pressed OK , the program returns to the main
screen. OK all states the same correction for all samples are loaded into memory (up 50). If
the box save changes is selected, in addition to the above, the data files are saved on your
hard drive. Cancel rejet the changes. ? shows a help on using this screen).
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2. Elimination of noise.
Lets remove small and frequent fluctuations of the diffractogram registration. Any action of this
type should retain the geometry of the profiles, which otherwise would leave inoperative
diffratograms ir order to study of profile analysis. XPowder uses two methods:


Functional filter. There is an average weighted by a continuous distribution function
characteristic of the diffractogram. Every calculation is done automatically by pressing
the button



or menu ‘Action -> Smoothing -> Functional filter’

Fourier transform. Removes higher frequencies in the Fourier transform using a cutoff
value and then calculates the inverse transform, which gives us the filtered
diffractogram. Is accomplished by pressing the button
or menu ‘Action -> Smoothing
-> Functional filter’. The Figure 3.7 shows how to handle tool for the Fourier filter.

Figure 3.6. Clicking on the position of the cursor eliminates the frequencies located on your
right and you get the filtered image of Figure 3.8.

Figure 3.7. The smoothed diffractogram can be seen at the top.

Home
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3. Background subtraction.

A

.

Figure 3.8.

B

An ellipse (Figure 3.8A, Flat roller box unchecked) or a segment (Fig 3.8B, Flat roller box
checked) can be used interchangeably, to automatically search for points where the background
polynomial will be calculated by LS methods. The horizontal cursor (and/or vertical) provide the
magnitudes of the semiaxes of the ellipse (or segment) that will cross the lower diffractogram
and whose contact points will be used to calculate the background function by splin (Auto
roller), splin + polynomials up to grade 20 (autoroller+polynomial) or tracing the background of
manually selected points (Polynomial customize). The buttons
perform background
subtraction on the active diffratogram (large button) or on all diffractograms loaded (top bar)
with the selected options. Figure 3.9. and 3.10. Large ellipses yield a soft elimination of the
background while small ones suppress the background completely. Different ellipse sizes
should be tried.

Figure 3.10.

Figure 3.11.
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4. Kstripping.
It uses the Rachinger method in its classic form, or in a dynamic modification that optimizes the
adjustment of the distribution functions of the profiles that are K-stripped in succession during
the 2 scanning. The method 'Advanced', which uses methods of Fourier on reciprocal
histogram, is temporarily out of order in the current version.
For proper K stripping, use very accurate values of  and [I / I (use
necessary).

when

The process is applied to a diffractogram (XPowder_program_dir\Examples\Quartz60_70.plv)
that shows the quartz reflections 113, 300, 212, 203 and 301 (figures 3.12 to 3.14).

Figure 3.12.

Figure 3.13.

Figure 3.14.
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5. Changing 2 step.
This procedure significantly improves, without the slightest deformation of the profiles, the
quality of measured with an excessive step diffractograms. This operation is very useful, as it
happens prior, to improve the quality of Kstripping, profile analysis or unit-cell refinement
Figures 3.15 and 3.16).

Figure 3.15.

Figure 3.46.
6. Merging diffractograms (Main menu –> Tools -> Merge)
This routine makes weighted additions and subtractions of diffractograms.

Figure 3.17.
You can add ADD or subtract Subtraction diffratograms. The top of the Figure 3.17 shows the
main diagram in blue and the secondary in yellow. The bottom image shows the sum of 50%.
OK Moves diffractogram calculated to the main screen. Caution: The program maintains the same file
name that was the main diagram.
Cancel Discard all operations and returns to the main screen.
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Zoom 1:1 Lets scale the charts to the original size. It is used when it has made 'zoom' up on
this screen.
Paint Fill color the main diffratogram.
Interchange Swap the main and secondary diffractograms.
Ratio 1:1 The two original diffractograms have the same weight.
Weight Slider cursor that lets ponder the diagram secondary.

Home
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Chapter 4. Searching subfiles and chemical restrictions.
The entrance to this screen (Figures 4.1. y 4.2.) from the ‘main screen’ or from other parts of
the program by clicking the button

(Advanced Options on qualitative analysis).

F
Figure 4.1. PDF2 advanced seaching options

F
Figure 4.2. AMSCD advanced seaching options

On both screens, the database can be exchanged, select subfiles or put restrictions on
chemical composition using Boolean logic (And, Or, Not and combinations).
The subfiles of each database are selected in the box Subfiles . The Apply button in Figure 4.1.
establishes what the selected subfiles will be loaded the next time you start XPowder (default
setting when using PDF2).
Chemical restrictions:
In a general way you can discard previously in searching phases containing elements
lanthanides or actinide (leaving unmarked respective boxes), elements with atomic number
Lower than stated, or higher than those given in Upper box. The hydrogen is excluded from
these restrictions.
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Boolean conditions:
You can choose up to 11 different chemical elements that are involved in the search for
components of the sample. To select just click on the symbol in the periodic table of Figures
4.1. or 4.2. A new push on the box, delete the item from the list. Reset button removes the list.
All items selected must into the chemical composition of the crystalline phase.


And: All selected elements must into the chemical composition of the crystalline phase.



Or: At least some selected element should belong to the chemical composition of the
crystalline phase.



Not: None of the selected elements must belong to the chemical composition of the
crystalline phase.



Logical combinations: The three previous operators can be combined by selecting one
of the options under Boolean framework. It should be noted that the brackets have
priority over the logical operators and therefore, any operation between parentheses will
be carried out before the rest. The order in which chemical elements are selected is the
same generic sequences of A, B, C, etc. displayed within each of the options under
Boolean .

Example
Figure 4.3 shows, for example, how to find carbonates Mg, Ca, Fe or Mn in the subfile
'Minerals' of the database PDF2. The deleted patterns will be taken into account during the
search, as indicated in the subfile framework. The selected items are drawn with black
background in the periodic table and the sequence is on the list of yellow background,
under the title of Boolean framework. The complete logic condition appears developed in
the bottom of the screen:
Searchig for … (C and O) and (Ca or Mg or Mn or Fe)

F
Figure 4.3. Chemical searching restriction with PDF2.
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F
Figure 4.4. Chemical searching restriction with AMSCD.
Figure 4.4 shows the same as in Figure 4.3, but with AMSCD database. In this case, the
searching will be made on minerals formed at room temperature and pressure.
The OK key confirms the search conditions selected, while Cancel ('disabled' in the examples)
ruled out any changes made, but does not affect the selection of subfiles.

Home
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Chapter 5. Searching and matching.
The identification (searching) of substancescan be obtained from the home page (Figure 1.2)
manually by using the 'Database-> Databse Boolean Searching "and automatically with the
keys

(One click searching) or

(Advanced searching):

This button performs the search completely automatically, using the search options
active at that time (see Chapter 4).
This button will display 'Advanced Options' described in Chapter 4, before
performing the search.
In all cases, the results appear on a 'floating' list into the tool Matching , critical to correctly
identify and confirm the crystalline components (Fig. 5.1).

Figure 5.1.
Figure 5.2 shows the tool Matching (ver 2004.04.57) in detail. The example was created from a
sample of monomineric Celestine - Sr (SO4) after using the key
(One click searching) on
the mineral PDF2 subfile, including the deleted phases. Each file contains from left to right, a
check box where it should be confirmed () the presence of the mineral. Then there are a six
number string that correspond to the 'Set' (first two digits) and 'File' (the other four) of the
database. The following is the Euclidean hyperdiste that has allowed the identification (smaller
is better in terms of the adjustment). Following is the name of the previous stage, or not, the
letter D, indicating that the file has been deleted from the database. The blue flag is on the first
line because is the best full least-squares fit of the possible records. It is noted that all first
solutions are 'Celestine', because this mineral appears repeatedly in the database.

It can select (or discard) the crystalline phases identified correctly by ticking the appropriate
box, or pressing the keyboard space on the active line. You can also use the Del key to
remove lines and keys Up , Down , Page Up , Page down , Home and End to move on
it.
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Figure 5.2. ‘Matching’ tool. Results with PDF2 database. (Please see updates Chapter)
To avoid the recurrence of similar results, ticking into the box Skip results , as explained in
Chapter 2, figure 2.1. In this case, the best solution is shown as in Figure 5.3, where the mineral
'Celestine' appears only once.

Figure 5.3. The box Skip duplicates was ticked in advanced searching options.
The remaining suggested phases (D Bopurnonite, etc.) have an excessive hyperdistance, so it
will be to select as the most likely phase "Celestine" (box is marked √). To discard the rest has
been pressing Uncheck).
Similar results can be obtained with the database AMSCD, which displays the list this time with
blue color (Figure 5.4).
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Figure 5.4. Results obtained from the database AMSCD. The Skip duplicates box is unchecked.
By clicking on any of the lines of the list, with shades of gray, a graphic overlay of the active
record on the graphic pattern is made. If on the main screen ticked the
box also
shows the positions of the bars for K. If, moreover,
is marked, are shown in
orange clear the positions of the bars K.
In poliminerics samples is the same way, but the list of suggested phases includes incorrect
solutions and it should be analyzed using the 'matching' tool. The example of the Figures 5.5
and 5.6 shows qualitative analysis of a sample with four mineral components (etc.) on the
subfile 'Minerals' of PDF2, without taking into account 'Deleted' cards and Skip duplicates with
the option selected.

Figure 5.5
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Figure 5.6.
Figure 5.7 shows the result list. It is noted that the phase with lesser Euclidean hyperdistance (0,025
bornite) does not match the one that best fits by least squares (0,028 Fluorite syn). It is for the user
decides which ones are the most appropriate allocations. In this case, and given that some phases can be
identified really isostructural terms of those obtained after a detailed analysis with this tool we reach the
conclusion that these are shown in Figure 5.8. To be ticked the

box, the bar charts of the
database, automatically weighted, overlapped with the original using color codes. To stop the
cursor on reflection, they show the rates of the reflections of each component (box with a yellow
background on 2=26º in Figure 5.6).
In addition to 'Set', 'File' and hyperdistance, the tool 'Matching' figure of 5.6 contains the
following messages:
Penalty : Order on the list according to the hyperdistance.
Weight : It varies between 0 and 1. Is the fraction of heavy intensities of the database record
that best fits the experimental.
Selected : Number of cards accepted and marked (√). The maximum value is 11.
Found : Number of phases suggested during 'searching'.

‘Matching’ commands (Figure 5.5.)
. It allows you to add to the list new results through new qualitative analysis.
. Rejects all the results and hide the tool.
. Saves the current results, which could be recovered, to be charged the same
diffractogram subsequently, through the order
. Both orders appear repeatedly in other
parts of the program. It also can be retrieved at any time from the menu on the homepage (for
example to contrast or implement the results of this sample other of the same nature):
File -> Mi favorite compounds
Lets unit-cell refinement of the crystalline phase corresponding to the actual card,
both automatic or controlled way. (Horizontal blue flag in Figure 5.6). (See Chapter 9).
. It allows the non linear least squares quantitative analysis for of the phases identified
including statistical and global amorphous stuff, overall from the database records. The program
takes chemical composition and density from the database in order to calculate the linear mass
absorption coefficients. If these data are not present in the database, the program assigns
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approximate coefficients. The overall mass absorption coefficient of the sample is calculated
during the process. The program assigns the RIR factor (Reference Intensity Ratio) value of the
card in the database. PDF2 use in this sense the coefficient 'I/Icor', which is usually wrong in
most cases, as documented by the fact that there are numerous examples in which a single
crystalline phase shows variations of up to an order of magnitude in the same database (for
example, a mineral composition as invariant as is the quartz 'I / Icor' ranges from 2 to 20,
leading to errors of up to 50% by weight and even mayors). Other times this factor is not
included in some chips from the database. In conclusion, to ensure proper quantification each
investigator must use their own values of the RIR coefficients. The best way to calculate it is
through registration Diffractometer setting of a 'pure pattern' of each substance to quantify, 50%
mixed and homogenized with another 'standard reference' stable (as far as possible and
crystallinity homogeneous mass absorption coefficient similar to set of mixing problem). This
often sometimes unlikely. The Corundum or synthetic (Al2O3) powder are often used as
standard reference, after being passed through a 20 m sieve. The RIR factor is calculated by
dividing the maximum intensity of the reflection phase of the pattern pure by the intensity of the
reflection maximum of corundum. But it is much better, though more laborious, making the ratio
of the integrated intensities of all reflections of each phase. More details on the quantitative
analysis are shown in Chapter 6.
It incorporates the record to the list of standard patterns (text file 'std.txt').
Allows the estimated diffractogram of the actual card for the active database
(horizontal blue flag) in accordance with the standard profile of lines and Caglioti equation (see
Chapter 10). Not included in calculating the asymmetry of the peaks, but if the box K2 and, or,
K are activated in the initial screen, the corresponding profiles are calculated. Subsequently,
the profile can be calculated subtracted from the original diagram. The latter can be used to
highlight the remaining components of the experimental diffractogram residual. The asymmetry
of the peaks is not included in the calculation, but if case of the K and, or, K boxes are
activated in the main screen, the corresponding profiles are calculated. Subsequently, the
calculated profile can be subtracted from the experimental pattern.
It let recover the last database pattern erased by Erase .
Within the framework Discard pattern are buttons that enable solutions to eliminate recurring
patterns ( Duplicates ) , PDF2 ‘deleted’ patterns (’Deleted’) or a particular solution ( Erase ).
This last, clears the list of the active row (horizontal blue flag). Can be replaced by the key Del
of keyboard.

Wipe Discard all results from the list.
Unchecks. Erase all the results from the list that have not been marked. Can be replaced by the
Esc keyboard.
Select It let select the actual pattern on the list. It is equal to clicking on the box  of the
pattern list. Can be replaced by the Espace keyboard.

They eliminate respectivelly the tyni, minors and largess
components according to values into the boxes Tiny cut-off 5 y Minor cut-off %
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Perform least squares fitting of better database pattern of list according to the selected
button option ( Minors, Largues o Both ) . This button is unable in the case of
is
checked.
Others options:
Launching “MyDatabase.Myd”

(See also update 2010.01.10)

Following commands are used:

(Main menu). Write the actual experiemtal Bragg reflections in a new record in
‘Mydatabas.MyD’ (fig. 5.7)

Fig 5.7
Exports the crystallographic data of active database (no reflections) to the new experimental
record file (Figure 5.8, data in red). This data can be edited before finally being recorded in
'Mydatabase.MyD' with the order

Fig 5.8
Export directly the actual record of the active database to 'Mydatabas.MyD'.
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The first pattern of "mydatabase" should be created with a diffractogram of our own laboratory
diffraction. Thus, the experimental model for the rest of the database will be related to it.

. When marked, the database record appears on a floating screen (Figure 5.7).
Anothers options :
When marked, check the database record and corrects original 2 error
scroll (-0.007 in the example). Corrected values are graphically displayed on the main screen
(matching).
. When checked, the main features of database pattern are displayed (figure 5.7).

Figure 5.7.
Equal to
It incorporates the record to the list of standard patterns of the program (text file
'std.txt'). It is equal to
of figure 5.6.
It creates the file ‘Card.txt’ with the actual data record information in the directory
of the program.
Displays the full content of the original database record:

.
When checked, and click the button
between the experimental and calculated patterns is drawn.

, the difference diffractogram

When marked, the results list will apply to all diffractograms loaded. This option
can be also selected on the main screen.

Home

45

46

Chapter 6. Quantitative analysis by RIR (Reference Intensity Ratios) methods.
Preliminary: The phase quantification by X-ray powder diffraction methods is a complex process due to factors that
mainly depends on dealing methods used in the diverse laboratories. Factors such the alignment difractometer, type
of slits, linearity in the response of radiation counters , uniformity in the size of grains of the sample, orientation linked to
how to prepare the sample or the habits, etc make many published results are of an error greater than the one
intended. Spectacularly wrong can be some results based on the measurement of the intensity of a single reflection
corrected by factors of proportionality, in some cases obtained by different laboratories to own or taken from literature
('Easy quantitative Analysis'). Other more sophisticated methods, including the Rietveld method, can provide more
precise solutions, but require an exquisite care in sample preparation, registration and in parameterization of
diffractogram models, both instrumental and structural components. XPowder uses non-linear least square methods for
full diffractogram opposite of a weighted combination of diffraction diagrams taken directly from the database (another
method that will explain later -Chapter 7- is based on adjustment for diagrams Experimental patterns). It was
subsequently corrected, within the possibilities it raises awareness of the pure phases, factors such as components and
amorphous absorption. The same definition of 'component amorphous global' (Global Amorphous Stuff) should be taken
in any case as an approximation to a reality that is described with difficulty. By using all reflections of each component
makes it minimizes effects such as the preference orientation, but there is no doubt that not just the problem completely.
So it is desirable, select those standard cards that fit the diffractograms, among the possible solutions found identical. It
is very interesting in this sense to use the option 'Skip duplicates', as the program adjusts the best database records
among identical results. No less important is the election of appropriate RIR factors because they involved directly %
weighting of each phase. Finally XPowder indicated that performs the calculations properly, according to wellestablished methods in general treaties of Statistics and Crystallography, so the quality of the final quantifications
depends only on the modes of operation of each user.

Beginning with the 2004.3.1 update, XPowder incorporated into the professional versions a
powerful tool that allows precise quantitative studies done by methods of nonlinear least
squares on a full profile of the full diffratogram and that takes full advantage of the information
contained in the database records. The analysis can be conducted on a isolated specimen or
groups of up to 50 samples simultaneously. The weighting is achieved with the standard
method RIR (Normalized RIR Method), described by Chung (1974: "Quantitative interpretation
of X-ray diffraction patterns. I. Matrix flushing method of quantitative multicomponent analisys.
Jour. Pf Applied Crystallography, v.7 , 519-525). Another method much more accurate
quantification will be explained in Chapter 7.
Although the initial versions, the amorphous components were excluded from this quantitative analysis, the program
XPowder has the ability to generate a pseudo-RIR factor for the Global Amorphous Stuff that is optimized for each type
of overall chemical composition, so that the program uses the 'experience' of previous analysis and optimizes the ratios
as an 'historic' (this must be taken into account in cases where the program optimizes your values in the midst of an
experiment in quantitative analysis, in which case it is recommended repeat all the calculations made in the same
session). The pseudo-factor of amorphous RIR is calculated from statistics that include the standard deviation of the full
accounts of the diffractogram and the relationship of 'accounts crystalline / background accounts', from an initial value
definable preferably in each lab. The results of analysis of amorphous are more valid in terms of analyzing samples of
similar composition. The results are better when amorphous samples are similar composition. The results are invalid in
any case when the crystalline composition is incorrect. Complementary uses the ‘Absorption-Diffraction Method’ that
involves calculating the absorption mass coefficients of each component and the total sample. The latter is calculated
on the composition of the departure from the standard method RIR. The automatic use of these methods assumes that
the database contains the chemical composition of each phase. In other cases XPowder provisional values assigned to
the parameters m / r, which can be modified by the user. The composition (Ci) of the component (i) is obtained in the
mixture (s) from the fraction of the mix function (Xi) of each partial diffractogram, which is obtained by non-linear
method of least squares (Heavy optional) on the full profile:

Ci= Xi ()i/()s
2 instrumental deviations optionally can be corrected during the refinement process.
The procedure that the user should be further simplified to the maximum, because it is not
necessary to sample preparation patterns or the construction of curves and abacus for obtaining
the weight percentages. The only requirement is that the database records used in the
evaluation include information on the chemical composition and value of the RIR (Reference
Intensity Ratios), which is customary in the latest versions of PDF2, but are not included in the
database DifData-AMSCD database. In another case, these values can be added by the user
with data measured in the laboratory or estimated from samples of known composition. The
quality of the results is generally good and depends only on the quality of the diffractogram, the
database patterns, the value of the RIR and its universality. It is always preferable to use mixes
of patterns and corundum with particle size of 20 m to about 50% by weight and measure own
RIR values.
The protocolose shown in the following example (corresponding to the sample C. PLV of the
sub-directory \ EXAMPLES that is installed with the program):
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1. We must never subtract background (this will differ in recent versions of the program of
previous ones).
2. It should be read automatically or manually peaks of the diffractogram pattern in order to calculate the d-spacing of
the most accurate manner.

3. We have to make a correct identification of crystalline phases and select them  in the
window Results of tool 'Matching' (see Chapter 5, Figure 5.7 and 5.8).
4. We must come to the window of quantitative analysis (Fig. 6). This can be done from the tool
'Matching' (
) or from any other part of the program (for example, Menu on the main
page -> Quantitative -> LS RIR Database cards).

Figure 6.1.

5. The tool of quantitative analysis appears as in Figure 6.2, showing the previous results
obtained directly from the parameters that the program has a default. RIR and  RIR values
are calculated and incorporated automatically from the content of the database. If any of these
records is not the factor I/ICor, the program assigns a provisional 1. Subsequently can be
changed by the user to appropriate values, obtained in the laboratory or from literature. The lack
of data density and chemical composition is also approach by the program.
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Figure 6.2.
In any case, you can always modify the values of the parameters RIR and  for each type of
composition (including the amorphous pseudo-RIR value) and recalculate the quantitative by
pressing
. Right part of this button performs the simultaneous analysis of all the
loaded in computer memory diffractograms (50 maximum). All data are collected in the archive
(logfile.tmp) that can be saved at any time from the menu "File-> Save Log File as TXT'.

Figure 6.3.

Description of the RIR tool (Figure 6.2.)

This is the file of the active diffractogram. Can be
changed by clicking

in the text box.

By checking the boxes are made respectively the following:
 It takes in account the background in according factor calculation
 Adjust the analysis to the current range of 2.
 The experimental data are weighed according to w = 1/√Counts
 K  is included in the calculation of the profile function and the graphics (does not
affect the quantitative analysis).
 The D-space values of the database patterns are refined

Statictis are Included 'Log file' and graphical output.
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If checked, 2 experimental pattern offset is refined. Maximun 2 offset must be = Max offset
value. According R for convergence is Max R.
It is defined as::

R= Σ { w(Io - Ic ) / Σ wIo
To obtain good values of R is necessary to use those cards in the database whose intensities
best fit our experimental diffractograms. The best results are obtained with their own records
(mydatabase).

.
Head of quantitative table of active experimental pattern. First column = Set (two digits) and file
(four digits). Second column =phase name. Third column=(1) if phase will be quantified, and 0
for no analysis. ‘Fract’ column shows L.S. fractional composition of reference phase ( 0 to 1.
‘RIR’ similar to ‘Reference Intensity Ratio’ of phase reference, for all experimental pattern. Must
be experimentally measured and can be edited and saved.’% W Unc Ab’ % weight uncorrected
for absorption. ‘mu/rho‘ masic absorption coefficient calculated from chemical and density
values of database record. % W Xtal column shows % weight (Sum= 100%) of crystalline
components. Last columns is equal from previous but includes estimated Global Amorphous
Stuff % (GAS), obtained by:

GAS=
Where:

{ [(Σ I ) / N]2 +  2}½
i

I is diffracted intensity in the point i . N = Number of measured points in X-Ray pattern.

= Ii standard deviation.
The non-linearity of the GAS factor value is corrected by using mixtures with known contents of
amorphous (glass in our case), and fit with a polynomial. For a Bragg-Brentano configuration,
nd
th
automatic slit and CuKradiation and 2 monochromator we can use the 5 grade polynomial:
True

2

3

4

GAS = -25.8483 +3.7592·X+ 0.6203·X -0.0535·X 0.0016·X -0.000016·X

5

Where X= GAS calculated from above formula. To perform linear correction is necessary to
include an instruction on the ‘XPowder.ini file, containing the list of the polynomial coefficients:
Amorphous_Polynomia_Coef = 0 1 (no polynomial correction).
th
Amorphous_Polynomia_Coef = -25.8483 3.7592 0.6203 -0.0535 0.0016 -0.000016 (for the 5
grade polynomial of the example).
RIR factors must be measured experimentally on the diffractogram of an artificial mixture,
whose components are known weights. Among these components must have a stable pattern,
common to all samples to be analyzed (quartz, fluorite, NaCl, corundum, CeO, B6La, etc). After,
a prior quantitative analysis is done with XPowder, using initial RIRphase values equal to one.
The final RIRphase factors are determined for each component according to:

(

RIRphase= % W Xtalphase

/ % W Xtal reference pattern) · (Weight(mg) reference pattern / Weight(mg) phase)

The first two factors are obtained in the penultimate column of the output table of prior
quantitative analysis and the latter two are the real weights of each component used to prepare
the artificial sample. The calculated RIRphase values can be then used in future analysis in order
to obtain absolute percentage results. Note that only need to use an artificial mixture for each
paragenesis.
Across the table shows the standard deviation in brackets after each outcome.
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Tools
Allows loading specific configuration parameters for each type of samples or associations,
that has been previously saved with
configurations of usual samples.

. This latest order allows you to create specific

It allows you to add manually database records to be weighted in the quantitative
analysis. It is necessary to know before the reference (Set and File) of each record.
Select, or discarded, alternately all database records from the list of quantitative analysis.
Clears the list.
Unit-cell refinement using active reference phase pattern.
The theoretical and difference patterns, based in the database cards, are calculated from
the quantitative composition. The program uses the active profile parameters (Caglioti
parameters and pseudo-Voigt average profile function). The calculation does not include
asymmetric peaks, but the effects of the lack of monochromatism of the radiation.
Allows you to select the color and size of the pen bar of the active database
record (orange horizontal bar in the example in Figure 6.2) who is drawn in the diffractogram
pattern graphic (Figure 6.3).
The program makes quantitative analysis with the current parameters are listed in the
table (as in Figure 6.2). Right part of this button performs the simultaneous analysis of all the
loaded diffractogram patterns in computer memory (50 maximum). All reulsts are collected in
the archive (logfile.tmp) that can be saved at any time from the menu "File-> Save Log File as
TXT'. It is assumed that they all have the same qualitative composition, although it admits that
some component has zero % in composition), as shown in the ‘log file’ example:
-------------------------------------------------------------------------Quantitative section based on PDF2 cards
Sample= C:\XPowder\SAMPLES\A.plv
Card

|

Phase

| RIR

·

%Weigth

|Mu/rho ·

%Weight

--------------------------------------------------------------------------77-2093 | Fluorite, syn
77-1904 | Gypsum
77-0529 | Celestine
77-1378 | Barite

|03.80 · 01.9(0.6) |0115.2 · 01.8(0.8) |01.8(0.8)

· ·Ca |01.70 · 02.1(0.6) |0060.8 · 01.8(0.8) |01.8(0.8)
·

|01.90 · 26.5(0.8) |0082.6 · 24.7(1.0) |24.6(1.0)

· ·Ba |02.80 · 69.5(9.4) |0286.4 · 71.7(7.7) |71.4(7.7)

Global amorphous stuff

|00.55 ············|···················|00.4·····

A.plv: R-according factor= 0.0274
Density= 4.281(g·cm-³)

µ/Dx of the mixture= 224.3 cm²·g-¹

Sample= C:\XPowder\SAMPLES\B.PLV
Card

|

Phase

| RIR

·

%Weigth

|Mu/rho ·

%Weight

--------------------------------------------------------------------------77-2093 | Fluorite, syn
77-1904 | Gypsum
77-0529 | Celestine
77-1378 | Barite

|03.80 · 15.2(1.7) |0115.2 · 14.9(1.7) |14.8(1.7)

· ·Ca |01.70 · 15.9(0.6) |0060.8 · 14.3(0.8) |14.3(0.8)
·

|01.90 · 32.5(1.4) |0082.6 · 31.5(1.4) |31.4(1.4)

· ·Ba |02.80 · 36.5(7.6) |0286.4 · 39.3(6.3) |39.2(6.3)

Global amorphous stuff

|00.55 ············|···················|00.4·····

B.PLV: R-according factor= 0.0303
Density= 3.808(g·cm-³)

µ/Dx of the mixture= 158.4 cm²·g-¹

Sample= C:\XPowder\SAMPLES\c.plv
Card

|

Phase

| RIR

·

%Weigth

|Mu/rho ·

%Weight

--------------------------------------------------------------------------77-2093 | Fluorite, syn
77-1904 | Gypsum
77-0529 | Celestine
77-1378 | Barite

|03.80 · 30.8(8.4) |0115.2 · 31.0(7.0) |30.8(6.9)

· ·Ca |01.70 · 24.7(0.7) |0060.8 · 22.8(0.9) |22.7(0.9)
·

|01.90 · 27.4(1.3) |0082.6 · 27.3(1.4) |27.1(1.3)

· ·Ba |02.80 · 17.1(0.9) |0286.4 · 18.9(1.0) |18.8(1.0)

Global amorphous stuff

|00.55 ············|···················|00.5·····

c.plv: R-according factor= 0.0207
Density= 3.439(g·cm-³)

µ/Dx of the mixture= 122.0 cm²·g-¹

Sample= C:\XPowder\SAMPLES\D.plv
Card

|

Phase

| RIR

·

%Weigth

|Mu/rho ·

%Weight
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-------------------------------------------------------------------------------------77-2093 | Fluorite, syn
77-1904 | Gypsum
77-0529 | Celestine
77-1378 | Barite

|03.80 · 13.0(1.9) |0115.2 · 12.7(1.8) |12.6(1.8)

· ·Ca |01.70 · 16.8(0.6) |0060.8 · 15.1(0.8) |15.0(0.8)
·

|01.90 · 33.0(1.5) |0082.6 · 32.0(1.5) |31.8(1.4)

· ·Ba |02.80 · 37.3(7.4) |0286.4 · 40.2(6.2) |39.9(6.1)

Global amorphous stuff

|00.55 ············|···················|00.6·····

D.plv: R-according factor= 0.0263
Density= 3.817(g·cm-³)

µ/Dx of the mixture= 159.2 cm²·g-¹

Summary of quantitative analysis of crystalline components
-------------------------------------------------------------------------------------Sample
Fluorite, Gypsum
Celestine Barite
R-acc
Densit C.Mas
A.plv
01.8(0.8) 01.8(0.8) 24.7(1.0) 71.7(7.7) 0.0274 4.281 224.3
B.PLV
14.9(1.7) 14.3(0.8) 31.5(1.4) 39.3(6.3) 0.0303 3.808 158.4
c.plv
31.0(7.0) 22.8(0.9) 27.3(1.4) 18.9(1.0) 0.0207 3.439 122.0
D.plv
12.7(1.8) 15.1(0.8) 32.0(1.5) 40.2(6.2) 0.0263 3.817 159.2
Summary of quantitative analysis of crystalline compounds and amorphous stuff
-------------------------------------------------------------------------------------Sample
Fluorite, Gypsum
Celestine Barite
Amorp R-acc Densit C.Mas
A.plv
01.8(0.8) 01.8(0.8) 24.6(1.0) 71.4(7.7) 00.4 0.0274 4.281 224.3
B.PLV
14.8(1.7) 14.3(0.8) 31.4(1.4) 39.2(6.3) 00.4 0.0303 3.808 158.4
c.plv
30.8(6.9) 22.7(0.9) 27.1(1.3) 18.8(1.0) 00.5 0.0207 3.439 122.0
D.plv
12.6(1.8) 15.0(0.8) 31.8(1.4) 39.9(6.1) 00.6 0.0263 3.817 159.2
End Quantitative section
--------------------------------------------------------------------------------------

In addition to the tool of estimate quantitative, a table is shown with the active database card (Fig. 6.4).

Figure 6.4.
This card is very similar to that described in Chapter 5 (Fig. 5.9). It also added to the pattern
graphic hkl indices of the identified phases (Fig. 6.3) with the button
, manually correct the
 error and alternately working in mode 'Profile Analysis (Chapter 8), or edit mode Bragg´s
reflections (

)

Auxiliary buttons

The first nine buttons have the same significance as in other parts of the program. They are important on this page
(Kstripping) and

background subtraction).

Move the diffractogram pattern to the right or the left.
Decreases the zoom level.
Performs analysis profile of reflection marked with the left mouse button.

Choose which hkl index are shown on screen when it stops the cursor on the graphic
pattern.

Home

52

Chapter 7. Quantitative analysis using experimental standards.

This is the most accurate way to quantify phases through X-Ray diffraction by the powder
method. However requires a careful handling of samples, both of which are used as standard as
those that are analyzed.
The method requires the record of diffraction patterns of pure crystalline compounds with the same
composition and similar crystallinity to those present in the speciment. When the quantitative analysis is
performed, the program makes an adjustment for non-linear least squares to find the mix of diffractogram
standard patterns to the experimental pattern.

If the crystallinity among the specimens and standard patterns are very different, it is desirable
to make records with different crystallinity patterns. The program will make the weighting of
each of them, as if they were separate phases. May also be included diffractograms of
amorphous substances for global quantification of them in the analyzed mixtures. The use of
internal standards of known weight (eg 10% of corundum Al2O3) allows absolute quantitative
analysis.
During the analysis the  displacement and the mass absorption coefficient are refined. Data
must be statistically weighted.
Once obtained the diffractograms standard patterns, it is easy for serialized quantitative
analysis with a precision that is generally higher than those obtained by Rietveld methods or
RIR-database based correction.
The quantitative analysis are more accurate when made with care the following:









The volume of standard sample and specimen used in all registrations should be the same. An minimum % of
Internal standard compound can be artificially added to the specimen.
The pressure of compaction of crystalline powder should also be similar.
It is necessary to use a stable sample pattern to control the derive of the X-Ray meter. The best thing is to
use is a pressed tablet having similar absorption coefficient which samples to be analyzed, wherever possible.
The same radiation, monocromatization system, set of slits, detector and values of discrimination of the
detector should be used forever.
The diffractograms of the tablet pattern and the standard patterns should preferably be in the same session.
Where then is necessary to create new standard patterns, must be measured also shows stable tablet
pattern, in order to correct derive or decay.
The historic change of intensity is corrected by a factor, which is the ratio between the two measures (Iold/Inew).
To this value, you can use a single reflection, or rather the cumulative intensity of several reflections and even
entire diffractogram.
Exceptionally, they can be used calculated diffractograms from the crystal structure, through programs such
as Cerius, Mercury, etc., whenever possible to normalize the intensity by a appropriate factor.

Access to such analysis is done from the main menu with the command:
Quantitative -> SL Experimental Patterns

There are three subcommands (‘Edit/Create group’, ‘Select group’ and ‘Analyze’), which will be
as follows:
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Edit/Create group

Figure 7.1.
Open To open and edit a previously created file that contains group of crystalline and, or,
amorphous phases. These files are text format ( 'ascii') and the extension '. LST'
Save It allows to save a group phases for later reuse with Open .
Cancel Return without any operation.
New Lets create a new group.
Exit Return to the main screen, after requiring the recording of the group created.
Del Erase data from the active compound whose order number appears in the box under the
message ' Select compound’.
Accept Accepts the selected pattern. Equivalent of pressing the right arrow.
Examine Lets explore the computer disk drives to locate the file of the standard substances
(Barite.PLV in the example). When you load the file, the boxes Label , File and Common
parameters are filled automatically. These should be identical for all phases listed. The figure
Global scale is 1 normally but can be modified with the same approach that the term Scale,, as
shown in the following paragraph. All the boxes may be edited, but 2-theta ini, 2-theta step y
and Wavelength must coincide with those of the corresponding specimen diffractogram
patterns.
-1

-3

The values of lineal absorption coefficient Mu(cm ) , density Rho(g·cm ) , SET and CARD are
optional, and should be entered manually. If the first two are not introduced, is not performed
the absorption correction. CARD and SET are used to superimpose the reflection graph bars of
the database records. The value of box Scale is 1 normally. Must be modified if the search
pattern has been made after observing a variation of the intensities of the tablet standard
sample with respect to other historical patterns used in the same association.
The left and right arrows (framework Select compound ) let go through the list of patterns, or
introduce a new one.
Figure 7.1 shows, for example, the fourth compounds (number 25 in the Select compound
frame) for a association which includes all the possible data.

Select group
Lets explore the disks from the computer to select a file (.LST) created with 'Edit / Creat group'.
Once loaded, the same group can be invoked repeatedly by using the Analyze menu or the
button
on the main screen.
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Figure 7.2.
The list on the left shows the components of the association and the files it contains
diffractograms standard patterns. You can select () part or all components of the list (Order
All). If you have entered the values of the absorption coefficients and densities, you can tick
Absorpt corr. You can also refine the mistakes of shifting angles 2 (Refine 2-theta). You can
also weight the experimental data ( check box Weight data ).
Maximun number of cycles. Limits the number of least squares cycles.
 R-Int for convergence When it reaches this divergence value , the analysis stops even have
not been completed cycles. Smaller values provide more accurate results.
results.
Init whole mass absorp . Initial estimated mass absorption coefficient for the specimen. It can
be manually modified.
Exit Lets leave the quantitative analysis.
Cancel. Cancel any operation, and leaves the quantitative analysis.

Go Makes quantitative analysis.
Analysis options: There are two different operating modes.

1.
2.

The sum of components are 100 % fitted.

In turn provides two options:

2.1. Without internal standard (Free weighting): If not selected any internal standard (none),
diagram calculated will be fitted in accordance with the experimental, but the results have a
relative nature, generally do not total 100 (Figure 7.3).

Figure 7.3
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2.2. With internal standard. You can select from a list of components whose weight is known as
internal standard (48% of corundum in the example of Figure 7.4). You can use a component of
the mixture itself or added artificially.

Figure 7.4.

To select the internal standard, you double-click on the appropriate line of the list (Corundum in
the example), or on the box
. In the latter case the active compound is selected
from the list. A new double-click on this box, discarding the internal standard. The quantitative
composition (48% in the example) must be entered manually. The result of the analysis will be
absolute in this case (Figure 7.5).

Figure 7.5.
The results (Figure 7.6) are displayed in the main graphic above and to the left. They include
statistics and some auxiliary parameters obtained during the process. The calculated pattern
(mix function) is shown with red dots overlapped by the diffractogram. The difference between
standard and experimental diffractograms are shown in green at an height of close to 10% on
the main screen and a 80% on the auxiliary lower pattern.

The header of the results screen (Fig. 7.5) shows the number of cycles performed before
convergence, the factor of agreement, the mean square error final and informs us of the
absorption correction.
The agreement factor ( According factor) is defined as (2012.04.01 and later versions):

According Factor =

{  [ w( I -I
n

o c

)2 ] /

 w [ Io2 ] } ·n·p

n

where Io are observed intensities and Ic calculated intensities. n = number of experimental
points, p= number of standard patterns. n·p is constant for a each experience and it is used
only for scale purposes.
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Hide Minimizes the floating screen of figure 7.6. It's like you press the button - .
Exit

Lets leave the analysis.

Save diff Dif Lets save the difference pattern in PLV format.
Repeat Lets repeat the analysis. The program leads to the figure 7.4.
PDF If you have filled the boxes SET and CARD (Fig. 7.2), and check the box PDF, the bar
graphs of the database are displayed on the main screen.

Figure 7.6.

Figure 7.7.
The options on the main screen can be used (Fig. 7.7) to draw the desired details on the diffractogram graph. In the
example has been marked Checked to display all the patterns selected in the tool Matching. It has been unchecked the
box Based standards, not to be mixed on the screen the results of quantitative analysis with the names of the phases of
the database. Many other alternatives are possible.

Note that we can perform a quantitative analysis regardless of one or more phases. In these
cases, the difference diffractogram lie only to'experimental' stage of non-quantifiable phases.
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Thus, we can save this difference file and use it later to analyze individual profiles, for example,
with results generally more accurate than those obtained by deconvolution techniques. Figure
7.8 shows a quantitative adjustment as shown in Figure 7.6, which has excludes one of
components (Bentonite). The diagram of differences, in blue, displays the diffractogram of the
pure bentonite, which can then be studied separately (figure 7.9). Some peaks of other phases
can not be completely eliminated and appear in the difference diffractogram as residual sharp
reflections.

Figure 7.8.

Figure 7.9. Detail of the difference diffractogram corresponding to Figure 7.8 where you can
appreciate the isolated pattern of bentonite.
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The partial results and other calculation details are displayed on-screen text of a yellow
background (Fig. 7.6) and are recorded in the 'log file', as shown in the following list:
-------------------------------------------------------------------------------Least squares quantitative analysis Section. Sample: C:\XPowder\SAMPLES\D.plv
Full profile refinement method
Standard's file= C:\XPowder\Salts.LST
__________________________________________
Historic Global Scale Factor= 1.00
____ Begin cycle

1 __________________________

Accomplished 2-theta angle correction
Direct coefficients matrix

divided by 1000:

00340479 00219720 00007577 00017374
00219720 00469209 00029085 00025070
00007577 00029085 01140231 00009856
00017374 00025070 00009856 00303487
__________________________
Inverse coefficients matrix (x 1000000):
0.0042

-0.0020

0.0000

-0.0001

-0.0020

0.0031

-0.0001

-0.0001

0.0000

-0.0001

0.0009

0.0000

-0.0001

-0.0001

0.0000

0.0033

__________________________
Correlation coefficients matrix:
1.0000

-0.5481

0.0119

-0.0212

-0.5481

1.0000

-0.0389

-0.0434

0.0119

-0.0389

1.0000

-0.0144

-0.0212

-0.0434

-0.0144

1.0000

______________________________
Acumulated Counts for observed diffractogram

= 51166

Acumulated Counts for calculated diffractogram= 36637
________ Composition _________
Barite

52.9

( 0.3)

Celestin

27.5

( 0.3)

Fluorite

09.1

( 0.1)

Gypsum

10.6

( 0.3)

______________________________
Sum =
Density

100.0

( 1.0)

3.989( 0.040) g·cm-³

Linear absorption coefficient

58.465 cm-¹

______________________________
______________________________
According factor= 0.05130

Defined as Sum[[Int(o)-Int(c)]^2]/Sum[Int(o)^2]

Relative Root-mean-square error= 0.07933
The percentages have been calculated weighing the data.
The selected composition is unsuitable or incomplete
Absorption correction= Yes
____ Begin cycle

2 __________________________

Accomplished 2-theta angle correction
Direct coefficients matrix

divided by 1000:

00340479 00196180 00008363 00015846
00196180 00456333 00030140 00025144
00008363 00030140 01139641 00010019
00015846 00025144 00010019 00325783
__________________________
Inverse coefficients matrix (x 1000000):
0.0039

-0.0017

0.0000

-0.0001

-0.0017

0.0029

-0.0001

-0.0001

0.0000

-0.0001

0.0009

0.0000

-0.0001

-0.0001

0.0000

0.0031

__________________________
Correlation coefficients matrix:
1.0000

-0.4962

0.0088

-0.0176

-0.4962

1.0000

-0.0398

-0.0473

0.0088

-0.0398

1.0000

-0.0139

-0.0176

-0.0473

-0.0139

1.0000

______________________________
Acumulated Counts for observed diffractogram

= 51166

Acumulated Counts for calculated diffractogram= 37131
________ Composition _________
Barite

54.6

( 0.7)

Celestin

25.8

( 0.6)

Fluorite

08.7

( 0.3)

Gypsum

10.9

( 0.6)

______________________________
Sum =
Density

100.0

( 2.1)

3.994( 0.084) g·cm-³

Linear absorption coefficient

59.394 cm-¹

59

______________________________
______________________________
According factor= 0.02407

Defined as Sum[[Int(o)-Int(c)]^2]/Sum[Int(o)^2]

Relative Root-mean-square error= 0.07685
The percentages have been calculated weighing the data.
Absorption correction= Yes
____ Begin cycle

3 __________________________

Accomplished 2-theta angle correction
Direct coefficients matrix

divided by 1000:

00322047 00196784 00008635 00013832
00196784 00469212 00029085 00026019
00008635 00029085 01140231 00010886
00013832 00026019 00010886 00325783
__________________________
Inverse coefficients matrix (x 1000000):
0.0042

-0.0017

0.0000

0.0000

-0.0017

0.0029

-0.0001

-0.0002

0.0000

-0.0001

0.0009

0.0000

0.0000

-0.0002

0.0000

0.0031

__________________________
Correlation coefficients matrix:
1.0000

-0.5049

0.0070

-0.0106

-0.5049

1.0000

-0.0369

-0.0515

0.0070

-0.0369

1.0000

-0.0153

-0.0106

-0.0515

-0.0153

1.0000

______________________________
Acumulated Counts for observed diffractogram

= 51166

Acumulated Counts for calculated diffractogram= 37711
________ Composition _________
Barite

49.4

( 0.7)

Celestin

30.6

( 0.6)

Fluorite

08.9

( 0.3)

Gypsum

11.2

( 0.6)

______________________________
Sum =
Density

100.0

( 2.2)

3.963( 0.086) g·cm-³

Linear absorption coefficient

56.124 cm-¹

______________________________
______________________________
According factor= 0.01662

Defined as Sum[[Int(o)-Int(c)]^2]/Sum[Int(o)^2]

Relative Root-mean-square error= 0.07821
The percentages have been calculated weighing the data.
Absorption correction= Yes
____ End

cycle

3 __________________________

Home
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Pattern stacking. (See also ‘Rearranging diffraction patterns’ and
‘Homogenization of 2 scan intervals and steps’ in New features of ver 2010.01.10 ).
Chapter 8.

XPowder can work simultaneously with a maximum of 50 diffractogram patterns. In this way, is
also highlighting aspects that are not seen when working with isolated diffractograms, such as
phase transitions, composition or crystallinity. The program allows the representation in
perspective (3D) and by projection with level curves and, or, false color (2D).
3D Screen
To enter the 3D display (Figure 8.1) uses the button
menu.

or the command 'Stack' from the main

Figure 8.1. 3D Visualization of a sequence with a recorded temperature variation.
The blue bar from the list on the left shows the diagram of the main screen active and can be
changed by clicking on the list with the left mouse button. Fields marked () correspond to the
patterns that are drawn on the figure. It can be selected manually.
The tool Z-axis vector can control the direction and depth of the third axis (Z) by dragging the
red dot on the small screen of a blue background. The buttons
,
and
set to zero
displacement of the axis vertical, horizontal or both respectively.
modify the sensitivity of
the drag of the mouse on this screen.
change the height of the patterns, enabling the
stack as the figure of 8.4.
The tool Graphics options selects the items shown in the graphic (axes, background, labels,
etc.) or highlight the active pattern ( Emphasize active ).
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Figure 8.2

In figure 8.2, have used a gray color palette (
active chart with a specific color (

), a blue background (

) and has set the

yellow).

In Figure 8.3 has been removed to fund the entire package (

).

Figure 8.3.
You can use the matching tool, both in the 3D and in the 2D representations, in order to
graphically superimpose database records in experimental patterns. Figure 8.4 shows an
example in 3D (tick box hkl). In presenting 3D is necessary to put the horizontal scroll to zero (it
can be used to the button

)
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Figure 8.3.
Figure 8.4 also shows the use of the tools Z-axis vector in order to visualize a sequence of the
same diffratogram patters. The area of circles (red and green in the illustration) lets recognize
the peaks correspond to the relative intensities of each phase of the database.

Figure 8.4.
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2D Screen

In this screen you can enter only from the 3D display by pressing the button

. The result is shown in Figure 8.5.

Figure 8.5
The colored curves, calculated by quadratic interpolation methods, show different scales of
intensity, as the key to the bottom, and can be scaled depending on the choice ( Intensity
scale) to the value 100 of the respective partial patterns (Option I/I100 ), at maximum value of
each diffractogram in the range of used 2 (Local Option, is selected by default) or absolute (
Counts ). You can select a logarithmic representation (Mark Log scale )). Instead of isolines
can be used false color or both representations ( Isolines , False color or Both Options).
You can also subtract/add background with the button

.

2specific intervals can be selected by clicking and dragging with the left mouse button.
and

buttons are used to extend the 2 interval.

Orders
/
allowed to edit/hide the list of patterns used for the mapping, whose
file names are displayed in the right column of the chart.
The bar pattern of databases can be drawn, in combination with the tool 'Matching'. In this
sense, the button
allows the drawing/delete these same bars directly on the map of
intensities. The name of the crystalline phase and the hkl reflections index appear, when the
cursor stops on and maximum of the intensity map (Fig. 8.6).

The values of minimum isoline, equidistance, maximum isoline and surface
smoothing (a value 0, produces no smoothing of the data) can be respectively introduced in these boxes.
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The button
change.

is used to redraw the map when a parameter or the list of diffractograms

When a data PLV format type is used, including the parameter 'Temperature', the column on the
left shows a temperature values (Figures 8.5 and 8.6). If a recording of patterns has been done
while the sample is heated and subsequently cooling has been recorded, it should tick Sort, to
display the records in a historical arrangement and not temperature arrangement because, in
the latter case, the records obtained at the same temperature, during the ascent and descent,
they would appear together.
If the process is independent of temperature, the sequence of presentation list is the same used
to load the respective data files.

Figure 8.6. Change pf phase around the 110 º C. A widespread loss of crystallinity is observed. This is
marked by the widening of the maximum that precede the formation of the higher temperature phase.
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Figure 8.7. Details of the previous figure. The indexes (001) of the phase formed at higher
temperatures are shown overprinted. The curve level of 50% (between yellow and green) marks
the evolution of FWHM along the sequence.

Can be noted that while the 3D presentation allows patterns with any data format (RAW, UDF,
TXT, etc.), with different exploration ranges of (2angles initial and final) and even different 2
steps between successive intensity measures, the 2D option requires all diffractogram
patterns have been registered under the same experimental conditions, because XPowder
uses nonlinear interpolation techniques for the drawing of the isolines and the calculation of the
false color requiring that restriction.

By clicking on
Is obtained
. This eliminates the interpolation of data, which
involves creating maps of the previous figures and limited representation to the original patterns
(very similar to colored Debye-Scherrer patterns, Figure 8.8). The number (4 in the example of
the Match ) is the width of each diffractogram.
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Figure 8.8.
The button
allows to do calculations of expansion coefficients. When the tool Thermal
coefficients is present, simply click (while press down the Alt key) points of the map from
which you want to measure the thermal dilation coefficientf. Note that you can make a
measurement for each HKL direction, which allows studying the thermal dilation tensor (Fig.
8.9).

Figure 8.9.
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Chapter 9. Unit-cell refinement.
XPowder has an advanced tool that allows comfortably the refinement of the unit-cell even if the
sample has several components. The initial parameters are approximate values a,b,c, and
The results include the optimized new lattice parameters with corresponding statistics and the
possibility to systematic study of extinctions of space-group and come to the study of the
existence of partial or total superstructures.
As is well known, these data from initial cell unit are very difficult to calculate from the powder
patterns, so that, wherever possible, it should be results obtained by methods of single crystal,
such as those that often of database records. If the substance has been previously identified
and the lattice parameters are included among the information in the database, such values can
be used as initial values. When the tools' Matching 'is present, XPowder read them directly. It
can also use the data ofcell isomorphic substances, even though the chemical composition is
very different. In other cases, it is sometimes possible to calculate 'ab initio' of the unit-cell from
powder patterns, through the use of specific programs, which often use methods of "trial and
error ' to propose possible solutions (' TREOR ', etc).
If the box
(Human Factor) from the initial screen is checked, most of the refining process
is done automatically without user intervention, although this need not lead to better solutions.

XPowder uses a non linear least squares routine that allows the simultaneous refinement of the
lattice parameters a, b, c,   and , and the instrumentals (horizontal and vertical)
displacement of the sample.
As a general rule, it is always preferable to devote some time to make the necessary alignments in the diffractometer,
rather than trusting the quality of results to the purely mathematical refinement of instrumental parameters. This is
because the number of parameters to refine (6 from unit-cell and 2 instrumentals) may be too high compared to the
available number of reflections. On the other hand, if the patterns are poor quality, it is possible that during the
successive refinement cycles, the parameters really interesting, ranging from too bad correct values and there is no
convergence in the overall refinement process.

Some parameters to refine, can be linked or fixed, so as to facilitate the calculation by using
smaller matrices. For example, if the a tetragonal unit-cell is refinded, the parameters a and b
can be linked(a = b) and the values of  and can be fixed If, moreover,
the diffractometer is correctly aligned, you can skip the instrumental correction, so that only the
cell parameters a and b are refined.
Other times, particularly when there are isomorphism or order-disorder phenomena, it may be interesting to refine a
unit-cell of high symmetry in a system of lower symmetry (for example, a crystal with initial orthorhombic cell can refined
in monoclinic system or even in the triclinic system). This strategy is often used in structures type spinel, perowskita,
garnet, etc.

Before making the refinement of a unit-cell, the displacement of 2 angle should correct using a
standard pattern (better internal standard), remove the component K (‘K stripping’) and
'read' the d-spacings of experimental pattern (better manually through the left mouse button on
the main chart which automatically). The elimination of the component K is not indispensable,
but in many cases can improve the precision of refined parameters up an order of magnitude. It
is not desirable to do background subtraction in any case.
The process of refinement can be accessed from various parts of the program. For example, in
the initial screen, the button
comes directly to the refinement tool (Figure 9.3). However, it is
always desirable that the tool 'Matching' is present, and that the initial crystalline phase is the
current one. Simply press the button
of this tool to obtain the refined unit-cell or to do
further refinement cycles.
In the example in Figure 9.1, the program is available to refine the unit-cell of the mineral
'Celestine', having been identified and incorporated into the tool 'Matching'. It is observed that
the HF check-box of the main screen is selected. The phase, which provides the initial lattice
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parameters is the third of the tool 'Matching', which appears in the figure on a blue band
(Celestine).

Figure 9.1.
By clicking Unit-cell comes the unit-cell refinement process. In Figures 92 and 93, shows that
the program has performed automatically constraints due to the space group of crystalline
phase (orthorhombic P lattice, ) and restraints for the instrumental alignment
parameters. The values of the initial and refined unit-cell, including statistical and volume are
also shown directly.
It can see that in the main graphic (figure 9.2) have been drawn calculated HKL lines for the
refined unit-cell, but in a primitive and lacking space symmetry elements (screw axes or glide
planes). HKL types are grouped by colors at different heights. The colors correspond to those of
the axes of the Unit cell parameters framework. The reflections h00, 0k0, 00l, 0kl, h0l, hk0 and
hkl show from top to bottom. This distribution is done to facilitate the fast identification of
isolated reflections. These can be studied in detail by 'zoom' on the upper main graphic (Shift +
left mouse button), or in the lower secondary display.
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Figure 9.2

By pressing OK will get the figure 9.3.

Figure 9.3.
From the screen shown in Figure 9.3 is you can do:






Show / Hide bar chart of the refined unit-cell. (Box Bars ).
Restrict the drawing of hkl reflection groups attached to specific symmetry space
elements (Bravais lattices, screw axes or glide planes, ‘0kl, h0l,..., hh*l’ framework) .
Initially there are no restrictions except those due to the lattice type. It can see that by
stopping the cursor on the respective option buttons, a message appears overlapped,
which contains information on the space symmetry associated with the systematic
extinctions, linked to each HKL group, which facilitates the study of space group.
Redraw reflections ( Redraw ).
Draw the reflections by groups (Framework Draw reflections ).
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Modify 'manually' values calculated using cell cursors for each crystallographic
parameter.
Fix/Refine parameters in the next cycle ( Fixed
check-box of each crystalline
parameter or instrumental parameters of the framework Cylindrical sample alignement.
Changing the crystalline system and Bravais lattice for the next cycle of refinement.
Ignore the results in order to initiate a new unit-cell refinement with different conditions
(Reset).
Print graphic ( Print ).
Copy the graphic to the clipboard ( Copy ).
Back to the main menu ( Main ).
Make the refinement of another crystalline phase of the specimen pattern and listed in
the tool 'Matching' ( New ).
Perform a new cycle of refinement using the refined parameters such as new initial
parameters ( Refine ).

Refine eliminates the HF selection (human factor), so all the following calculations will be
controlled by the operator. The tool appears now as in Figure 9.4.

Figure 9.4.
La lista de la derecha muestra los valores de espaciados observados d(o) y calculados d(c),
índices hkl de cada reflexión, intensidades observadas referidas a cien y la diferencia entre los
cuadrados de los vectores recíprocos observados y calculados Q(o)-Q(c). Se puede recorrer la
lista y eliminar del cálculo (marcar ) aquellas reflexiones cuyo valor ‘Q(o)-Q(c)’ sea excesivo
2
(Qhkl = 1/d hkl). En el ejemplo de la Figure 9.4 se indica al programa que debe prescindir de las
reflexiones 131 y 412 , ya que están marcadas. En este punto el programa queda detenido
hasta que se pulsa la tecla Continue , lo que proporcionará nuevos resultados (Figure 9.5)
muy semejantes a los de la Figure 9.4, ya que apenas se han modificado las condiciones del
afinamiento.
The list on the right of Fig 9.4, shows the observed d(o)and calculated d(c) d-spacings, HKL
reflection index, observed intensities referring to 1000 (Int) and the difference between the
observed and calculated squares of reciprocal vectors Q(o)-Q(c). The list can be scrolled to
eliminate of the refinement (tick ) those reflections whose value 'Q (o)-Q (c)' is excessive
2
(Qhkl = 1/d hkl). In the example in Figure 9.4, we have decided that the program rescinds the
131 and 412 reflections (which were already marked for this purpose). At this point, the program
is paused until you press the button Continue , which will provide new results (Fig. 9.5) very
similar to the figure of 9.4, just because we have slightly modified the terms of refinement.
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Figure 9. 5.
Under the list of figure 9.5 there is a summary which contains the number of data used in the
latest refinement (58), the number of refined variables (lattice axes a, b and c), and the overall
According factor for Q (or, c) that, being very close to zero, indicates that the refinement has
been done correctly. In addition to this, the calculated errors for each of the results are obvious
signs of quality refinement (0.0084 Angstroms for a-axis, 0.0056 for b-axis, 0.0073 for c-axis
and 0.43 cubic Angstroms for unit-cell volume).
With the New order (Fig. 9.5), the unit-cell refinement of another component of the sample can
be done. In the example, by choosing 'Gypsum' and clicking Unit cell , the results for the new
phase are obtained directly (Fig. 9.6).

Figure 9.5. To summarize, in order to refine the unit-cell of each phase, the cursor is placed on
it in the tool 'Matching' and the button Unit-cell is then pressed. The procedure can be repeated
for each identified phase. See details in the text.
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Example: The determination of the ratio Ca / Mg in magnesium carbonates by PXRD is
usually performed through unit-cell refinement. The most likely result is obtained then by linear interpolation between
the parameters of cell in terms of extremes which have well established unit-cell parameters and chemical composition.
This is the general procedure used to obtain the exact term of any mineral having solid solution composition. What
makes XPowder interesting for this analysis is that this program calculates unit-cell parameters with a single mouse
click.
Example: By using the program XPowder, this real example has been developed in approximately two minutes.
Adjustment charts come from previous experiences.
1. Load a Calcite diffraction pattern.
(it is an optional but advisable action). On the other hand, the internal standard and the ‘spline’

2. K stripping
interpolation function

, can improve the quality of the unit cell refinement.

3. Searching (i.e., ‘one click searching’

or ‘advanced searching’

)

Fig 9.6
4. Click Unit-cell refinement (
5. Click

)

. The unit cell is now refined:
a-axis = 4.9361 ± 0.0040 Å

c-axis = 16.8475 ± 0.0219 Å

Unit cell volume = 355.49 ± 0.59 Å3

Fig 9.7
6. Error assessment: [Mg] = m · (p) ; where · (p) = error of the crystallographic parameters or unit-cell volume and
m slope of the adjustment line.
7. Results: The magnesium content of the specimen can be calculated using varied linear regression lines (Fig 1 to 6).

74

Fig 9.8 Mg(formula) = -2.5548· a + 12.79533= 0.13 ± 0.01

Fig 9.12 Mg(formula) = -0.0119· Volume +4.35=0.13±0.04

Fig 9.9. Mg(formula) = -2.935· a + 14.62516= 0.13 ± 0.01

Fig 9.13 Mg(formula) =-0.0107 ·Volume+3.94 =0.12 ±0.04

Fig 9.10 Mg(formula) = -0.587·c + 10.00645 = 0.12 ± 0.01

Fig 9.14. Mg(formula) = -2.77932 ·a +1 3.86 = 0.14 ± 0.01

Fig 9.11 Mg(formula) = -0.5188· c + 8.855 = 0.12 ± 0.01

Fig 9.15 Mg(formula) = -0.494169 ·c + 8.437 = 0.11 ± 0.01

75

Fig 9.16. Mg(formula) = -0.01083 ·volume + 3.98 = 0.13 ± 0.04
Black points: Regression data from experimental chemical and PXRD analysis. Data of the ‘Mg content = 0.5’ point in
the figs. 7 , 8 and 9 are of pure dolomite. Data of the ‘Mg content=1’ point in the figs. 2 , 4 and 6 are of pure magnesite.
Data of the ‘Mg content=0 are of pure calcite. Unit-cell volume = a · a · sin(120) · c (figs. 5 and 6).
Red squares: PXRD data from example

Fig 9.17 XPowder Program can do this automatically using a tool that calculates the terms interpolated from the values
of ending cells. This tool is derived from the main menu (tools ► Solid Solution), or from the cell refinement tool, by
double clicking on the text box of any lattice parameter. In the example, a carbonate type 'Mg-Ca kutnohorite' has been
identified (1) . The unit cell is refined (2) . Then, the exact term of the series is obtained by double clicking on the box of
the refined parameter b (3). The extreme terms and vicariant elements can be changed into A, B, C and D. The editable
file ‘SolSol.txt’ in the program directory, is a collection of unit-cell of exact composition phases as in the example:
Calcite
4.9963
4.9963
17.1092
90
90
120
Dolomite
4.808
4.808
16.055

90
90
120
Magnesite
4.646
4.646
15.139
90
90
120
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Chapter 10. Profile Analysis.
The reflection profiles provide information on the crystallinity. This concept can not be defined
uniquely as it covers many aspects of the real crystal, as are the average crystal size, the size
and distribution of crystal mosaic (it is often called in diffraction as 'coherent domain'), its form
and habit, uniformity in both, dimensions (including here the inhomogeneous deformation due
to active or residual tension) and composition of the lattice, etc.
This leads to significant changes to four elements of the observable profile:





Absolute and relative values of the integrated intensity of the profile.
Profile broadening.
Distribution function.
Asymmetry.

Absolute and relative values of the integrated intensity. Increases with the square of the
average radio of the crystal sections, perpendicular to each reciprocal vector, which produces
the HKL reflection. In the same way, the average of absolute intensity of the total diffracted by
a powder sample is a good measure of its overall crystallinity. By contrast, the 'relative
average' value, the most general expressed as a percentage (and also its standard deviation),
is inverse function of the overall crystallinity (the latter two figures are virtually independent of
the experimental conditions). All this are applied both to individual reflections and full pattern.
Here, the concept of crystallinity refers primarily to the size of grain. These values are
displayed directly by the program when the sample is loaded. These figures appear on the
screen in numerical or graphic forms when the Average and st has been checked (Figure
10.1).

Figure 10.1. The base of the blue-green band is the average for the overall intensity of the
pattern. The height of the band is the standard deviation. The crystals are small (Struvite). The
average value of intensities is% 8793 ± 6588
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Figure 10.2. The pattern corresponds to a mid-sized crystasl specimen (CeO). Average
intensities (%) = 0848 ± 1703

Figure 10.3. Pattern of large crystals specimen (B6La). Average value of intensities (%) =
0.644 ± 0.531

Figure 10.4. Powder individual profiles of CeO 111 reflection of low powder size (above) and
large size (below) grains. The intensities of the latter are divided by 106 in order that they can
be comfortably handled by the program. As will be seen below, there increase in the size of
the mosaic is related to sample larger crystals (as evidenced by the decrease in the width of
the profile). The K component of radiation has been eliminated, to adjust the profile to a
pseudovoigt function..
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Line broadening. The simplest measurement of dispersion (line breadth) is the a full width of
the intensity distribution at half of the maximum intensity (FWHM). If the distribution is not
symmetrical XPowder calculates the half of the maximum intensity on the left (w1) and right
(w2) hand side of the peak ordinate. The asymmetry is defined as w2/w1. XPowder also
includes the integral breadth , defined as the width of a rectangle having the same area and
height as the observed line profile. Area asymmetry (A2/A1) has similar sense with asymmetry,
by using of the left (A1) and right (A2) hand side areas of the peak ordinate. The shape of the
profiles is measured by the shape factor , defined as the ratio of the FWHM to the integral
breadth. Thus, the calculated parameter for a profile are:
FWHM = Full width at half maximum.
Asymmetry = w2/w1
Integral breadth 
Area asymmetry = A2/A1
Shape factor = FWHM /
The causes of the widening and shape of the profiles are:


Instrumentals
o 1. The radiation is not strictly monochromatic.
o 2. Geometry and diffractometer optical. Instrumental function.



Related to the specimen.
o 3. High percentage of amorphous materials (high background).
o 4. Mosaic size (coherent domain size in diffraction terms).
o 5. Heterogeneities and distortions of the unit cell
o 6. Non Uniform Strain’ (or simply ‘Strain’)

‘Non Uniform Strain' (or simply 'Strain') and 'Uniform Strain' are two different concepts. The first cause a
heterogeneous dispersion of the d-spacing values, resulting in a widening of different profiles in each . In the second
type, the sizes of all the unit cells modifying alike, as for thermal expansion or Pascal pressure, which causes a nonlineal displacement of the angles of the reflections patterns, but not the widening of the profiles.

Of all these possible causes of widening the profiles, only the latter two are related to the
nature of the analyzed crystals and are often referred as 'microtexture'. It is therefore
necessary to find a suitable procedure to subtract the effects of the first three, which are alien
to their own crystals, so that the shape of the ‘pure profile’, to say the profile due exclusively to
that microtexture, will be isolate.
1. Monocrhomatism. Of course, acquire the patterns with monochromatic radiation
through the use of serialized monochromators or synchrotron radiation is
convenient. But this is not always possible, so in some methods of microtexture
analysis (Scherrer analysis or Williamson-Hall) is needed, as a preliminary step, the
complicated process of elimination of the K  component (stripping). XPowder is
done with sufficient quality through the push of the button
. If the Williamson-Hall
methods are used, the elimination of K also must be performed on the
experimental instrumental function (see next item).
2. Instrumental function. The calculation of the so-called 'instrumental function' is more
complicated. This function describes the profile shape induced solely by the
diffractometer, and that conditions at last, the final resolution of this technique. The
instrumental function in theory can be calculated as the product of convolution of the
curves generated by each of the components of diffractometer (X-ray source, the
sample surface, divergence of the rotation axis, transparency of the speciment, set
of divergence and reception slits , monochromator, etc). The details of this
calculation can be seen in the book of HF Klug and L.E. Alexander, 'X Ray
nd
Diffraction Procedures', whose 2 edition has been printed by Wiley & Sons in
1974. In general this theoretical calculations are very complicated, because it is very
difficult the parameterization of the functions of each element of convolution.
Instead, experimental patterns of very high crystallinity compounds (B 6La, CeO, etc.)
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are often used in order to uses as an instrumental function. Then, the instrumental
profile broadenig can be modeling by the Caglioti equation:
B = U · tan + V · tan+ W + P/cos
2

2

Where B is the width of the profile for each pure angle . U, V, W and P have to be
adjusted from the very high crystallinity standard pattern (CeO, B6La, Corundum,...).
Other times and whenever possible, the instrumental function can be obtained from a
sample that possesses not only a high crystallinity, but a similar composition to the
studied specimen. In this case, the Caglioti function is tot used. The calculation of the
Caglioti function is performed automatically by XPowder, as explained in Chapter 11.
3. Background. Some methods of microtexture analysis, using only the reflection widths
(Scherrer and Williamson-Hall), needed to remove the background ( ) before
making adjustments in the distribution functions of the crystal reflections. However,
except in cases where it is really excessive, the background should never be
removed. The background should never eliminated when using the of WarrenAverbach methods, of course

The distribution function that XPowder used to model the pure profiles (profiles cleaned of instrumental
interference) is:

P(x) · e –

x² [4 · Ln2/]/ (B)²

+ [(1-)·B²/2(B²+x²)]p

Where:
x = free variable
B = Reflection broadening (refinable parámeter or experimental data)
and p are refinable parámeters
If =1p=0 the function is Gaussian
If =0p=1 the function is Lorentzian (or Cauchy)
If=0p>1 Pearson VII
If=0p<1 Super Lorentzian
If=0 to 1, p=0 Pseudo Voigt (Gaussian + Lorentzian)
If=0to 1, p1 Mixed function

Function value for x = 0 (maximum)
Asymmetry. XPowder adjusts, independently the right and left sides of the diffraction profiles,
so it is possible to quantify the asymmetry of both, areas as B parameters.
With a strictly monochromatic radiation, sometimes, the slope of the profiles is softer towards minors  angles. This
can be attributed to a lack of uniformity in the size of the unit cell, due to partial hydration process that causes
increased volume crystalline, by way of example.
If the slope is softer towards larger , the cause is more difficult to explain. Sometimes this can occur in the process
of crystallization from a solid solution, in which the more modern cells are form from isomorphic elements of smallest
radios. On the contrary, can be caused in the process of dissolution where the more soluble terms are largest radio
elements. In any case, systematic measures from the parameters of asymmetry and form factor described above can
be established.
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Profile analysis methods based on width and shape of the diffraction profiles.
The use of strictly monochromatic radiation allows very simple treatments of profiles in terms
of variance, so that when the profiles are adjusted to Cauchy functions, you can write:
Btotal = BInstr + Bsample = BInstr + Bsize + Bstrain
If the profile function is Gaussian the relationship is as follows:
2

B

total

2
Instr

= B

2
sample

+B

=B

2
Instr

2
size

+B

2
strain

+ B

From the analysis of the distribution function used by XPowder, a more general relationship
can be inferred for the pseudo voigt:
(1+)

B

total

(1+)

= B

Instr

(1+)

+B

sample

(1+)

=B

Instr

(1+)

+B

size

(1+)

+ B

strain

This equation allows easily deduce the value of the width of the reflections when this type of
profile function is adequate. The refinable parameter  is the Gaussian component of the voigt
function which is automatically calculated by Xpowder
1. Scherrer Method.

It is used to calculate the coherent domain size (uncorrected strain) from a single reflection
profile ( supposed monochromatic):
Size(m) = K · Å)/(10 · Bsize· cos)
The coherent domain size ‘Size(m)’ is often expressed in nanometers (hence the 10 that
appears in the denominator). (Å) is the wavelength of monochromatic radiation and o is the
central angle of reflection.
The width of the reflection Bsize can be FWHM, or the  integrated width, expressed both in
(1+)
radians. When the instrumental role is known, B sample can be obtained by the suitable
relationship Bsample = Btotal - BInstr ≈ Bsize. Otherwise, it can make a gross oversimplification
assuming that Bsize ≈ Btotal. Strictly, Bsample Bsize only for =0 (where Bstrain =0, see
below). K is a experimental constant (0.8>K>1.1), with different value when  instead
FWHM is used. Optionally XPowder calculates this value but generally uses K = 1

To measure the size of the coherent domain with Scherrer method, XPowder use the button
or the Strain and X-size command of home menu. Once on the appropriate screen, press
the left mouse button on
, or click just about any reflection profile, and the automatic
adjustment to a 'pseudo Voigt' function is obtained (is also fitted), as shown in Figure 8.4. It is
desirable to make a proper K stripping, and even an 'Spline' interpolation, before starting the
calculations. If you wish to obtain results expressed in absolute values, which can be
compared with those of other laboratories, the instrumental function should also be set in
advance. The background subtraction is not desirable to make, unless cases of very poor
quality patterns. In any case, the background subtraction should not be too 'aggressive'.
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Figure 10.5.
The data shown in the figure 10.5 are as follows:













2of the maximum (‘2-theta’ column).
If the object 'Matching' is present, hkl index are shown, on the contrary 2 is printed.
(Column 'Label').
Values' FWHM 'expressed in degrees of 2, both to the right side (R) as to the left
(L). Columns ‘(L)’, ‘FWHMº’, ‘(R)’
Gaussians components () of the adjusted functions by the Right and Left, as well as
the error of those values (Columns' Gauss-left ',' Gauss-full 'and' Gauss-Right '). The
statistical values for left, full and right profiles are also shown to the right of the chart
with red, white and blue respectively.
Drawings of the adjusted and difference functions (blue).
Drawing and value of experimental FWHM.
Corrected FWHM Value for the instrumental function (True FWHM), that should be
calculated for each diffractometer. In any case, the program uses latest available
function.
Integral Breadth in º. Coherent domain size in nm without correction instrumental
('Scherrer'). K = 1 is used and the widening of the profile caused by 'Strain' is not
taken into account.
Idem with instrumental correction (‘Corr Scherrer’). K = 1 is used and the widening
of the profile caused by 'Strain' is not taken into account.
Experimental profile integral counts (Integral Obs. Counts).
Calculated profile integral counts (Integral Cal. Counts).

If the box Fix is marked, the position of the highest profile is set at the exact angle 2q, which
has made the 'click' with the mouse. In another case, the program finds the position of the
maximum.
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If the box Pearson VII
refined.

is marked, the exponent p of the general distribution function is

If the box Spline is marked , the experimental data are interpolated virtually, through an a
cubic spline, and the position of the maximum with more precision is obtained.
The box Gap contains the interval which will be used in adjusting the distribution functions,
on both sides of the maximum.
If the box Caption is unchecked, any comments appear on the image.
The button Start allows you to start a new list of measures. It is used when switching
experimental options, or at the beginning of adjustments for special functions such as those of
Caglioti (for difractometer or sample), or Williamson-Hall microtexture analisys.
The button All lets you select all the profiles of the header list for subsequent calculations (Caglioti,
Williamson-Hall, for example).

The button Del lets you remove the current profile of the list (blue stripe).
The button Copy moves the graphic to clipboard.
The button Hide hides the tool . It is the same as pressing the button
.

again.

El botón Rejet profile elimina de la lista general el último ajuste.
The button Rejet profile lets you remove the last fitted profile.
2

The button B [uvw]
lets calculate the Caglioti equation. If the sample is a very high
crystallinity specimen, enables you to adjust the instrumental function (see Chapter 11).
The button Williamson-Hall performs the calculation of the size of mosaic and 'Strain',
according to the method of Williamson-Hall.
The button Warren-Averbach is equivalent to
, and go to a special display, where are the
tools necessary to perform calculations of mosaic sizes and 'Strain' by 'Warren-Averbach'
methods, as well as 'Log-normal' distributions. This button involves a reload of the original
data of the diffractogram pattern, so that all operations carried out before will be cancelled
(background subtraction, K stripping, etc).
All the partial results are listed in detail in the Log file for each of the analyzed profiles, as shown in the
following example:
----------------------------------------------------------------Profile Information Statistics (Parts of profile L= Left R= Right):
1

1

1 Cerian·

2-theta: 28.553 D-spacing= 3.1236
K-Alpha2 stripping has been performed
___________________________________
______________________________________________|
2theta|
028.55|1

Label
1

|(L)FWHMº(R)| (L) Counts (R)

Pseudo-Voigt Gaussian Weigh

| Left part |

Full

|____

|Right part | Int

1 C|0.158|0.149|01183505|01105825|0.440±0.011|0.420±0.016|0.403±0.012|100

_______________________________________________________________________________________
Observed FWHM= 0.3070 (2-thetaº)
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FWHM (After Instrumental Broadening Corrections)= 0.2838 (2-thetaº)
Current Instrumental Cagliotti

Coefficients (x 10000):

U= 0.032900

V= -0.035600

W= 0.019030

Asymmetry= 0.9438
Areal Asymmetry: 0.9344
Integral breadth: 0.362 (2-thetaº)
Shape factor (Observed FWHM/Integral breadth): 0.847
Max. counts: 21053
Uncorrected Size (Scherrer-neglects strain)= 29.7 nm. (Scherrer K=1)
K-Alpha2 and Instrumental Broadenig Corrected Size (Scherrer-neglects strain)= 32.1 nm. (Scherrer K=1)
Integral observed counts : 2289330
Integral calculated counts= 2385951
Pearson component has not been fitted for profile

2. Williamson-Hall Method .
The method of Scherrer explained above, uses a single X-Ray reflection for the calculations of
mosaic size, but provides no information on the 'strain' (), since this affects the profile
differently in each 2value:
= Bstrain / (4·tan)
Bstrain = · 4·tan
Where, Bstrain is the variance of the distribution due to 'strain', expressed in radians, and  is
the 'strain' defined as L/L. We note that the Bstrain value is zero at the origin (=0).
The effect of 'strain' on the broadening of the profile is generally very small compared to due to
the magnitude of the mosaic. To correct the effect of 'strain', the method of Williamson-Hall
can be used.
The variance of a pseudo voigt distribution having  Gaussian component can be expressed:
(1+)

B

size

+ B

(1+)
strain

(1+)

=B

sample

=B

(1+)
total

(1+)

- B

Instr

The method of Williamson-Hall calculates separately, the size and the 'strain' by two or more
orders of a reflection HKL, but gave no information on the size distribution, provided by the
method of Warren-Averbach , which will be explained later. Thus,
(1+)

B

sample

(1+)

=B

size

+ B

Size(m) = K·/(10·Bsize· cos)

(1+)
strain

(in Å , B in radians )

By removing and replace the values of Bsize and Bstrain, we get:
(1+)

B

sample

= {K·/[10· Size(m) · cos]}

 { ·4tan· }

(1+)



(1+)


By rearranging , we get
(1+
(1+)
(1+)
(1+)
{Bsample · cos}
= {K·/[10· Size(m)]}

· {4·sin}


This is the expression of the equation of a straight line y = b + a ·x , whose function values are
(1+
(1+)
y= {Bsample · cos}
and independent variables are x= {4·sin}
. If the experimental
values x are plotted versus y, the absolute values of Size(m) and  can be obtained from
the straight regression line.
(1+)

In this way, for x= 0 we can obtain the value of b = {K·/[10· Size(m)]}

(1+)
and the slope is a= 
. From b and a we obtain Size(m) and respectively.
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As can be seen easily, the size obtained depends on the hkl direction and at least two
observations are needed (eg 111 and 222). In isometric crystals can be used occasionally
reflections from different directions, although the detailed analysis tends to give a much richer
information.
With XPowder, this analysis is done via the button Williamson-Hall on the screen of the figure
10.5.

Figure 10.6.
The figure 10.6 shows an analysis of 106 Williamson-Hall made automatically on all reflections
of a diffractogram of CeO. The three models correspond to Gaussians, Lorentzians and
Pseudo Voigt models respectively. As broadening criterion has been used FWHM. The
constant K value from Scherrer equation is optimized (K = 0.852) (box Guessing Scherrer K
marked). The values of 'Strain' are expressed in% and are very low, according to the values of
the slope of the straight lines in all cases.
Other options such as ( Integral Bread ), (Weight data,instrumental correction (Inst.Corrc ),
right side, full side or left side profiles (selecting in the Profile zone framework, etc can be
used.
Figures 10.7 y 10.8 show the Williamson-Hall analysis performed on the h00 reciprocal
direction, with and without instrumental correction respectively.
Both the method of Scherrer as the Williamson-Hall, provide size values, as measured on directions HKL, whose
calculations involved in the entire volume of crystalline domains. That is the criterion used for statistical weight is the
volume. The term 'volume weighted' is used to refer to the sizes obtained, as opposed to the ' area weighted '
provided by other methods such as the Warren-Averbach which is explained below. In general the weight methods
based on 'volume' provide values greater than those achieved with 'areas'.
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Figure 10.7. Williamson-Hall plot for the h00 direction. The instrumental correction was made.

Figure 10.8. Williamson-Hall plot for the h00 direction. The instrumental correction was not
done
Home
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Warren-Averbach method.

A more comprehensive and accurate study of the diffraction profiles based on Fourier
analysis, attends the role of total profile (Rtotal) as a result of the convolution of the instrumental
profile (RInstr) with the function generated by the sample (Rsample), being the latter the product of
convolution of the size function (Rsize) and due to strain function (Rstrain).
Rtotal = RInstr * Rsample = RInstr * Rsize * Rstrain
The method requires the representation of diffractograms in reciprocal space, instead of doing
it in classic 2 function. Obtaining histograms diffraction in this space has very experimental
difficult, as it requires appropriate programming of diffractometer very different than usual.
XPowder uses an alternative path based on the theoretical calculationof histograms (ie
diffractograms with  constant) based on typical, (which is the usual way of presenting
the data) through interpolation methods for cubic spline. It has been proven the effectiveness
of this method that allows you to create reciprocal graphs with the same quality and form of
profiles than those obtained experimentally. The method is used both for the instrumental
function as to the sample function.
The Warren-Averbach method is a highly elaborated approach of size and strain analysis by
powder X-Ray method which uses the deconvolution of the structural line profile (true profile)
and the Fourier transform for evaluation of size of the coherent domain and strain (to say:
space dispersion d/d %). This methods states that the absolute values of Fourier cosine
coefficients are then product of the size and the strain coefficients (Bertaut 1949). The
coefficients can be numerically calculated and then related to the distribution of the column
length (L), defined as the distance in the crystallite, perpendicular to the diffracting planes hkl
(parallel to diffracting qhkl vector). The convolution of the size broadened and strain broadened
profiles in reciprocal space is the product of their Fourier transforms in real space. The
absolute cosine fourier coefficients (AL,q) of the true profile are:

AL,q= sAL·AL,q

[1]

Being
S


AL absolute cosine fourier coefficients size dependents,
AL,q absolute cosine fourier coefficients strain () L and q dependents and

q = 2·sin
If two or more order of the reflection for hkl plane are available in the diffractogram, separate
information for size and strain can be extracted assuming small strain values and Gaussian
strain distribution for all values of L. Applying logarithms to [1]:

Ln(AL,q)= ln(sAL) + ln(AL,q)
≈ ln(sAL) - 22L2q2<2L>


[2]

-2²L²q²<² >

where AL,q= e
L (theoretical expression value for
mean-square strain for the correlation distance L.
In successive plots of

(AL,q)

versus

q2

at fixed L values,


s



AL,q)

AL

and

<2L>

is the

are obtained from the

intercept of the strain lines (at abscissa = 0) and AL,q from the slope of the strain equations.
Note that they are a strains coefficients curve for each q profile.
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General procedure in W-A analysis .
1. The sample and instrumental profiles are normalized to maximum value=1 (figure 10.9.) and
plotted in the reciprocal space with constant step (abscissa = 2·sin
, ordinates =
counts, figure 10.10).

Figure 10.9. 2 histogram.

Figure 10.10. Reciprocal histogram
2. Deconvolution is carried out in order to obtain the ‘structure profile’ (‘pure profile’,’physical
diffraction line’,…) of the sample pattern (figure 10.11).

Figure 10.11.
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3. Absolute values of cosine fourier coefficients (AL) from the structure profile are calculated
and normalized to A0=1, and plotted versus column length L, perpendicular to the reflecting
plane hkl (parallel to reciprocal q diffraction vector. Figure 10.12).

Figure 10.12

The average LAREA size (uncorrected strain) is calculated from the tangent of the coefficients
nd
curve in (A0,0) point for AL=0 in inflection point (2 derivate=0, grey line in figure 10.12).
4. By selecting an upper Bragg’s order line of hkl size and strain coefficients values can be
separate, according to [2]

ln(AL,q) =ln(sAL)-2L2<2>q2
that is the straight line equation

y = b + a·x
where
b= ln(sAL)
a = -2L2<2>q2
x = q2
y = ln(sAL)
S
AL = eb
[3]

AL,q = exp(aq2)
[4]
2
2
< >= -a/2L (average value) [5]
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Then, it can be obtain the pure size Fourier-Cosine coefficients plot (column length probability
to be greater or equal to L) and the average area weighted size value (<L AREA> = 20.07 nm in
example) perpendicular to the (111) selected crystalline face (parallel to selected q reciprocal
vector figure 10.13),

Figure 10.13.
the



AL,q strain Fourier-Cosine coefficients plots for each analyzed profiles (figure 10.14)

Figure 10.14
and the strain (d/d = <2>1/2) versus column lengths plot (figure 10.15).

Figure 10.15
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Log-normal distribution.
Additionally in most cases of small particles or nanocrystalline powder, it can be calculated
then column length distribution by fitting to the log-normal distribution function (figure 10.16):

[6]

Figure 10.16

How does XPowder do this?
When a high quality diffractogram pattern is loaded, you can enter to Warren-Averbach module
(figure 10.17) by clicking

or Warren-Averbarch command of figure 10.5..

Figure 10.17.
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Selecting profiles:
Select the profiles by draping around the reflection with the left mouse button in any histogram.
The selected profile will be enlarged in the graphic with blue background (reciprocal
histogram) and green background (2-theta histogram). Alternatively select 2 lower and upper
limit values and pulse Actualize . Optionally, use Center in order to improve the symmetry of
the profile in the  interval.

Figure 10.18.
Definable parameters and computation

Figure 10.19.
Instrumental Profile section
Calculated: Allow calculate the instrumental profile by using the Caglioti approximation and
selected distribution function (Pseudo Voigt or Pearson VII) by using an instrumentalstandard sample (The National Institute for Standard and Technology- NIST, LaB6 by
example).
Experimental: Enable the use of a sample of equal composition and ‘infinite’ crystallinity for
instrumental broadening effects correction.
Compute Instr. Shows the selected instrumental profile.
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Include K-alpha2: The effects of the doublet K1-2 will be corrected if checked.
Instr correct: The instrumental correction will be applied if checked. Default is ‘Checked’.
Log normal size distribution section
Restraint sigma: Bind to actual value
 : Dispersion for log normal distribution. If Restraint sigma is checked the  value is not
calculated.
Compute (or Hide) Log-Normal size distribution: Compute/Hide log-normal size analysis
[7] and draw graphic of probabilistic distribution of L values (figure 8). The parameter used are
Larea and .

Selected Profile section
2-theta limits: Lower and upper 2-theta of the selected reflection. The values can be input
directly, by using of the displacement bar or by draping in the histograms.
Centre : The reflection is placed in the centre of the selected interval according to the
average or the maximum of the
profile. It will be automatically executed when
Compute_Coeff are clicked and the automatic box is checked.
Maximum or Average: Criteria for automatic centering of the profile
N polynom: Select de order of the polynomium for fitting the column length LAREA. Default value is 3.
Points: Number of cosine coefficients to be included in polynomial regression (A 0 to Apoints). Default value is 10.

Equal width: Restraint to be equal the width of all the profiles. This box is checked
automatically when the first profile has been analyzed by Compute Coeff.
Area weigt<Size> nm : Value of the area-weighted column length (LAREA nm) for current
analysis (both corrected or uncorrected strain)
Scherrer Size : Value of Scherrer size in nm for the current profile.
PROFILE n: Ordinal number of the actual profile
h k l: Editable label for actual profile.
Compute Coeff: Compute Centre (if the centre box is checked), Actualize and the average
area weigthted LAREA size (uncorrected strain) is calculated from the tangent of the coefficients
curve in (A0,0) point for AL=0 (figure 4). Uses [7], N polynom and Points parameters.
Inflection point section
X value: Centre for <Size>AREA calculation
Gap (nm). Interval of X value for lineal regression in orden to obtain then <Size> AREA WEIGHTED
value
Restraint X value: Bind X value to actual value.

Others parameters and commands
Max L : Upper limits in nm for column length in graphics. Default value is 45 nm.
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Size W-H Estimated volume weighted size (nm). This value can be improved from XPowder
Williamson-Hall plot module and can be changed manually by the user. It is used in the
calculus of .
Recover Allow to recoup prior searching PDF2 cards. It is uses for get hkl index of the
histograms reflections by stopping the mouse cursor on the graphics. By stopping in the
reciprocal histogram profile, ‘hkl’ index of the reflection is writing automatically in the ‘h k l’
editable label box.
N Bragg order Allow to show the first N reflection orders from the actual position of cursor.
2·sin(T)/L step Editable value of the step in reciprocal histogram. The change must be
actualized with the button Actualize .
Wipe Reset profile counter and analytical results.
Actualize Compute and redraw graphics according to actual parameters. It will be
automatically executed when Compute Coeff is clicked.
Exit Leave Warren-Averbach tools and go to XPowder home screen.
Compute W-A : Execute [1] to [5] Warren-Averbach analysis and draw figures 4 to 7. Uses
the profiles selected by checking in the list box of figure 12.

Figure 12.
Note: Use right mouse button for others pop-up contextual menus. Help button shows a quickly W-A user guide.

Warren-Averbach Quick Start User Guide
1. Select first order profile by draping with left mouse button in any histrogram (example: 1 1 1
reflection).
2. Centre profile and zoom (click Centre . Optional).
3. Change instrumental profile options (optional).
4. Compute Fourier coefficients (Click Compute Coeff ).
5. Repeat 1 to 5 for another order profiles (example: Select 2 2 2, 3 3 3, etc. reflections)
6. Compute Warren-Averbach (Click Compute W-A )
7. Compute Size Distribution for log-normal model (Click Size distrib . Optional)
Lectures.
Balzar, D., Audebrand, N., Daymond, M.R., Fith, A., Hewat, A. Langford, J.I., Le Bail, A., Louër,D., Masson, O.,
McCowan, C.N., Popa, N.C., Stephens, P.W. and Toby, B.H. (2004) J. Appl. Cryst. 37, 911-924
Bertaut, E.F. (1949). C. R. Acad. Sci. Paris, 228, 187-189, 492-494.
Warren, B.E. X-ray Diffraction. (1969). Reading, Mass. Addison-Wesley. 1990 Edit. 381 p.
Lucks, I., P. Lamparter, E.J. Mittemeijer, An evaluation of Methods of Diffraction-Line Broadening Analysis. Appliedto
Ball-Milled Molybdenum, J. Appl. Cryst. 37(2004) 300.

Home
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Chapter 11. Caglioti equation.
The Cagliotti equation calculates the width of the diffraction peaks (B), through the adjustment
of the three parameters (U,W,W,P) of the formula:
B = U · tan + V · tan+ W + P/cos
2

2

In principle, this function was used to synchrotron diffraction, but also can be used with any
other of X-ray monochromatic radiation. There must have an efficient monochromator or
eliminate analytically K component, so that the function of Caglioti can be used correctly.
Kstripping can be done by XPowder with enough precision, where values of wavelengths
and reason IK / IK are sufficiently accurate. (See Chapter 3.4).
To adjust these parameters (U,V,W,P), we have to calculate individual profiles, as explained
in Figure 10.4 and then, press the button
. The image of the Figure 11.1 will be
obtained.

Figure 11.1.
In the graphof figure 11.1, the values of experimental widths and initial Caglioti functions are
shown (Red circles= FWHM, Green circles= Integral broadening), both in algebraic and
graphic form (the last one previously saved on the hard drive of your computer). You can
adjust both the 'instrumental function' (when using a standard sample of a very high
crystallinity), as the 'sample function' which can be used latter in theoretical profile
calculations , or initial profile data in Rietveld analysis programs. Before making the Caglioti
adjustments, XPowder automatically calculated the 'pseudo-voigt' average profile of the
sample, whose Gaussian component appears in the top frame.
In this example, the Instrumental option must be chosen, because we want to adjust the
instrumental function of the difractometer. Pressing Compute functions are calculated and
adjusted for FWHM (red) and 'Integrated broadening' (green, Figure 11.2).
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Figure 11.2.
The least-squareadjusted functions are drawn with thick points in the analyzed interval and
with thin points in the extrapolated zones. The numerical values are printed on the bottom
right. If it is then pressed Cancel, the calculations will be discarded.

· If Instrumental is pressed, the calculated values will be applied to all instrumental corrections
which are required in the future. Alos, the file ‘Xpowder.ini’ (or ‘XPowder12.ini’) is updated:

[Profile]
InstrumentalU-Width= -0.000072152
InstrumentalV-Width= 0.000001197
InstrumentalW-Width= -0.000071989
InstrumentalP-Width= 0.000072325

(for FWHM)

InstrumentalU_WidthIB= -0.000058756
InstrumentalV_WidthIB= -0.000000209
InstrumentalW_WidthIB= -0.000058024
InstrumentalP_WidthIB= 0.000059880

(for integral broadening)

U,V,W and P parameters can also be manually entered into ‘Xpowder.ini’ (or
‘XPowder12.ini’).

· Touching Sample, the UVWP calculated values will be applied to new theoretical profile
calculations (for example when , by using 'Matching', you want to subtract from the
experimental pattern, a identified partial profile in order to explore comfortably the rest of
compounds. Auxiliar file ‘Broad.txt’ is now generated.
Home
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into

Chapter 12. Additional files.
XPowder.ini
It is a text file, which contains basic information about the initial configuration of the program.
Can be modified through a text editor. Some data is updated from the XPowder program itself.
The following example in green, it commented line by line (right in red).
[Xpowder]

Head

SampleDir= .\samples

Sample subdirectory in the directory program.

LoadFilterIndex= 2

Specifies the initial sample file format (1=All, 2=PLV, 3=Raw, 3=RD, 4=X’Pert,

5=Udf, etc.)
SaveFilterIndex = 1

Output data format files. All values are not valid.

DiagramForeColor= &HFF00FF&

Background color of main diffractogram in hexadecimal.

currentLd= Cu , 1.540598 , 1.54433 , 1.39217 , 0.5

Default anode: Element of anode, K, K,K, IK / Ik

lambda= Cr

, 2.28970 , 2.29351

, 2.08480

Normalized

lambda= Fe

, 1.93604 , 1.93991

, 1.75653

Idem

lambda= Co

, 1.78897 , 1.79278

, 1.62075

Idem

lambda= Ni

, 1.65784 , 1.66169

, 1.50010

Idem

lambda= Cu

, 1.5405981 , 1.54433

lambda= Mo

, 0.70930 , 0.713543 , 0.63225

Idem

lambda= Ag

, 0.559363, 0.563775 , 0.49701

Idem

lambda= W

, 0.208992, 0.213813 , 0.184363

Idem

lambda= Cu2

, 1.5405981 , 1.54433

, 1.39217

Idem

lambda= Dummy, 1.5405981 , 1.54433

, 1.39217

Idem

, 1.39217

values: Anode, K, K,K

Idem
You can modify or add radiation

lambda= Synchrotron, 1.5406, 1.5406, 1.5406

Idem for Synchroron radiation (The three values must be equal).

kalphaFT= 1

Parameter used in the Fourier filtering. There should be no change

hRoller= 1

Horizontal initial value of ‘roller’ in 2º, for background subtraction.

vRoller= 5

Idem vertical in % counts.

interpolate= 2

Initial number of points to be interpolated by spline.

2-theta_Tuner= 0.1

maximum2º for L.S. fifting in searching (0< 2º <0.4)

QUAntitative= True

Establishing the capacity to make quantitative analysis based on RIR

Amorphous_Whole_RIR= 0.5541791

Pseudo RIR global amorphous. Updates itself, according to the types of samples.

Monochromator_Constant= 1

Monochromator constant

rZoom= 50

Number of horizontal points of the window Zoom

iZoom= 50

Idem vertical

peakSearchMinInt= 4

Minimun initial intensities (%) in ‘Searching’

peakSearchSmoo = 0.2

Inital smoothing of maximum in ‘Searching’

SkipDuplicatePDF= False

If True: ‘Searching’ shows the better solutions from equal phases

[Initial PdfSubfiles]

Next instructions are for PDF subfiles

Deleted pattern= True

If True, Deleted PDF patterns are included in‘Searching’

Inorganic= False

If True,

Organics= False

Idem ‘Organic’

Mineral= True

Idem ‘Minerals’

MetAl= False

Etc. Can be modified from running XPowder

CP= False

Idem

NBS= False

Idem

FORensic= False

Idem

EDUcational= False

Idem

ZEOlite= False

Idem

EXPlosive= False

Idem

SCMaterial= False

Idem

CEMent= False

Idem

CORrosive= False

Idem

POLymer= False

Idem

DETergent= False

Idem

PIGment= False

Idem

PHArmaceutical= False

Idem

ICSD= False

Idem

Ceramics= False

Idem

[www]
XPowderSite= http://www.XPowder.com

‘Inorganic’ PDF patterns are included in searching..

URL and e_mail of Xpowder:
e_mail:support@xpowder.com

InstrumentalU-Width= 0.000003290

Current value (U) of the Caglioti for function instrumental FWHM

InstrumentalV-Width= -0.000003560

Current value (V) of the Caglioti for function instrumental FWHM

InstrumentalW-Width= 0.000001903

Current value (W) of the Caglioti for function instrumental FWHM

InstrumentalU_WidthIB= 0.000003714

Current value (U) of the Caglioti for function instrumental Integral broadening

InstrumentalV_WidthIB= -0.000003341

Current value (V) of the Caglioti for function instrumental Integral broadening

InstrumentalW_WidthIB= 0.000002228

Current value (W) of the Caglioti for function instrumental Integral broadening

Rem OldUValue= 0.000044

The lines that begin with REM are not read by the program.
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Std.txt
This file contains standard patterns and is used when you run the ' Edit-> Set 2-theta offset' or
push
from the home screen in order to correcting instrumental  misalignment. Each
standard begins with the key 'Begin standard", after the chemical symbol for the element of
used anode, the name of the compound and a list of  and intensities in scale thousand
(separated by commas). The end of each pattern is a row with the key 000.0000,000. The first
of the patterns whose name is 'None', lack of data and its presence is necessary, as in the
following example:
Begin standard

058.0049, 0020

086.1906, 0100

138.3980, 0020

086.4996, 0040

075.5847, 0020

Lambda= Cu

060.6048, 0050

104.2542, 0030

000.0000, 0000

088.9972, 0080

077.5737, 0010

None

060.9139, 0040

118.8626, 0100

090.7050, 0021

079.7871, 0020

000.0000, 0000

061.2713, 0030

124.2775, 0100

Begin standard

091.1794, 0100

079.9552, 0010

062.9841, 0020

150.8580, 0070

Lambda= Cu

094.8164, 0010

081.0554, 0030

Begin standard

064.6004, 0050

000.0000, 0000

Aluminum (Syn)

095.2357, 0190

081.3796, 0030

Lambda= Cu

065.5200, 0030

038.4720, 1000

098.3804, 0020

083.7256, 0010

069.1476, 0010

044.7380, 0471

101.0638, 0140

084.8748, 0010

Sodium

Choride

(Halite

syn)

070.1536, 0020

Begin standard

065.1333, 0219

102.8171, 0010

087.3647, 0010

027.3024, 0130

072.7817, 0020

Lambda= Cu

078.2271, 0239

103.3008, 0031

090.7551, 0020

031.6547, 1000

073.6395, 0010

Silicon(2)

082.4352, 0071

104.6351, 0010

092.7170, 0010

045.3954, 0550

076.2077, 0010

028.4106, 1000

099.0783, 0021

109.5222, 0010

094.5576, 0010

053.7887, 0020

077.0839, 0020

047.2499, 0550

112.0410, 0082

109.8503, 0010

095.0107, 0010

056.4108, 0150

080.8346, 0010

056.0584, 0300

116.5600, 0080

110.8154, 0010

096.1174, 0010

066.1488, 0060

081.4486, 0030

069.0537, 0060

137.4500, 0081

110.9755, 0040

098.6254, 0010

072.9777, 0010

082.0136, 0010

076.2928, 0110

000.0000, 0000

114.0680, 0030

102.0830, 0010

075.2129, 0110

083.6656, 0030

087.9290, 0120

116.0804, 0130

102.4429, 0010

083.8708, 0070

084.6848, 0010

094.8431, 0060

Begin standard

116.6098, 0100

103.7659, 0010

090.2991, 0010

086.3782, 0010

106.5978, 0030

Lambda= Cu

117.8378, 0080

104.0809, 0010

101.0693, 0020

092.9588, 0010

113.9622, 0070

Corundum

000.0000, 0000

106.0248, 0010

107.6764, 0010

094.5853, 0030

127.4020, 0080

025.5760, 0720

109.9103, 0030

094.8949, 0040

136.7419, 0030

035.1498, 0980

Begin standard

119.3563, 0040

096.0477, 0020

000.0000, 0000

037.7672, 0440

Lambda= Cu

127.0104, 0010

097.5282, 0010

041.6834, 0010

Quartz low (1)

Begin standard

129.7306, 0030

099.0396, 0020

Begin standard

043.3402, 1000

020.8264, 0220

Lambda= Co

142.0569, 0020

102.1170, 0010

Lambda= Cu

046.1754, 0020

026.6217, 1000

Quartz

000.0000, 0000

102.8261, 0010

Calcium Fluoride (Fluorite

052.5480, 0480

036.5006, 0080

024.2697, 0148

000.0000, 0000

· · (79-1906)

103.7715, 0010

Syn)

057.4981, 0960

039.4111, 0080

031.0354, 1000

Begin standard

103.9963, 0030

028.2350, 0920

059.7375, 0030

040.2379, 0040

042.7044, 0129

Lambda= Cu

105.7159, 0020

032.7239, 0010

061.1238, 0040

042.4168, 0060

046.1689, 0067

Calcium carbonate (Calcite

106.0151, 0040

046.9516, 1000

061.3031, 0090

045.7572, 0040

047.1493, 0009

Syn)

107.2017, 0010

055.7016, 0330

066.5144, 0380

050.0838, 0140

049.7232, 0037

022.9948, 0120

109.4260, 0020

058.4099, 0010

068.2018, 0570

050.5537, 0010

053.7215, 0062

029.3704, 1000

110.3477, 0020

068.5964, 0100

070.4114, 0011

054.8066, 0040

000.0000, 0000

031.3808, 0030

000.0000, 0000

075.7643, 0090

074.3001, 0010

055.2655, 0020

035.9231, 0140

078.0951, 0010

076.8727, 0017

057.1730, 0010

Begin standard

039.3546, 0180

Begin standard

087.2734, 0170

077.2342, 0010

059.8804, 0090

Lambda= Co

043.0940, 0180

Lambda= Cu

094.1097, 0070

080.4151, 0012

063.9282, 0010

Silicon

047.0672, 0050

Silicon(1)

105.6840, 0040

080.6922, 0070

065.6859, 0010

033.2200, 1000

047.4328, 0170

039.8796, 1000

112.9358, 0060

083.2078, 0010

067.6728, 0060

000.0000, 0000

048.4552, 0170

046.3690, 0250

115.4390, 0010

084.3481, 0050

068.0531, 0070

056.4865, 0040

067.7484, 0200

126.0590, 0080

085.1346, 0010

068.2451, 0080

057.3326, 0080

081.6145, 0200

135.0546, 0030

086.3465, 0040

073.3786, 0020

· (77-2108)

Note: The last two standard patterns have been created in the example from the Xpowder
program itself from PDF2 records, for tubes with anode of cobalt. This involves first obtaining
the different angles of the respective reflections, using the formula with the value of Bragg
wavelength described in the database information. Subsequently, these values are normalized
to the exact wavelength, for the same anode defined in the XPowder.ini file (eg currentLd =
Cu, 1.540598, 1.54433, 1.39217, 0.5).
There are commercial programs that do not perform this normalization of  and can cause during the operation of
correcting,  zero shift higher than the value that is tried to correct. In any case, what is more correct to directly enter
the values of  angles and intensities, observed directly on experimentas patterns obtained in well aligned
diffractometers.
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Favorites.txt
This file is used rarely, but it remains by compatibility with very primitive versions of the
program. They have fixed text format and aims to quickly find specific records of databases
through names, nickname or improperly written words. Each line contains the file (2 digits), a
space, the number of the card (file, 4 digits), a space and all the familiar names or aliases in
any language.
12
##
33
5
36
41
33
5
29
35
9
5
6
33
17
33

1234
####
1161
586
426
1475
268
593
696
496
432
628
263
664
541
311

set=two digits
file=four digits
key words
Cuarzo Quartz
Calcita Calcite Calcium carbonate
Dolomita Dolomite
Aragonito aragonite
Vaterita Vaterite Baterita
Celestina Celestine
Siderita siderite
Fluorapatito Fapatito
Hidroxiapatito Hapatito
Halita sal gema sal comun halite
Moscovita Muscovite
Hematites ocre
Weddellyte Weddelita Wedelita Wedellita
Yeso Gypsum

SolSol.txt
It is a text file containing the final stages of isomorphic series that can be used to interpolate
chemical compositions. Data from each phase are written on successive lines:
Phase name, eje a, eje b eje c
Calcite
4.9963
4.9963
17.1092
90
90
120
Dolomite
4.808
4.808
16.055
90
90
120
Magnesite
4.646
4.646

15.139
90
90
120
Forsterite
4.752
10.192
5.978
90
90
90
Fayalite
4.815
10.4597
6.0818
90
90

90
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Default.cnf
It contains the initial communication parameters and configuration of Philips PW1710/00/12 devices. It is only
necessary in the PLUS version.
[PW1712]
[Diffractometer communication port]
CommPort = 1
BaudRate = 9600
DataBits = 8
StopBits = 1
Parity = N
[Scan parameters]
ScanMode = CONTINUOUS
StartAngle = 3
EndAngle = 80
StepScan(2 - thetaº) = .040
IntegrationTime(sec) = 0.4
ScanRate(2 - thetaº / sec) = 0.1
Batch_mode= 0
[Pulse height analyzer]
LowerLevel = 35
UpperLevel = 70
[Diffractometer setting]
Monochromator= Graphite 2º
Filter= None
Slit_1 = AUTOMATIC
ReceivingSlit = 1/0.1/1
AutomaticSamplerChanger = PW 1775
Rem PW 1775,No,

...

Spinner= PW 1774
Rem PW 1774, No
ThermoController = Comm3:9600,N,8,1
Rem

False / Comm3:9600,N,8,1

MaxTemperatureCentigrade= 250
GraphicRecorder = PW 8203A
Rem

PW 8203A,

PW 8203, NO

SingleGobelMirror = NO
GeneratorVoltage(Kv) = 40.00
TubeCurrent(mA) = 40.00
Stand_by_2theta = 5.00
DiffractometerSite= <<To be personalized>>
[Profiles]
01 Profile 026.00 003.00
02 Profile 035.00 003.00
03 Profile 044.00 003.00
04 Profile 000.00 000.00
05 Profile 000.00 000.00
06 Profile 000.00 000.00
07 Profile 000.00 000.00
08 Profile 000.00 000.00
09 Profile 000.00 000.00
10 Profile 000.00 000.00
11 Profile 000.00 000.00
12 Profile 000.00 000.00

Other specific ‘*.cnf’ files can be created for particular applications, through editing ‘default.cnf’, or using the
‘File-> Save Setup file’, in the acquisition diffractograms module. Also it can be used ‘Load Setup file’ in same
module.
Home
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Chapter 13. Data collection from the diffractometer.
This option is available in the version XPowder PLUS for the PW 1700/10 diffractometers through a
PW1712 serial dual interface.

Figura
13.1
The figure 13.1 shows two examples of null-modem cables to link directly the PC (9 or 25 female pins
connector) to the diffractometer (25 female pins connector). This cables are rather different to the original,
and the diffractometer connector should be in the 25 pins male position 1 of the PW1712 connector (This
position is the I/O channel. Position 2 is output only). Remove also the null-modem box which is delivered
with the PW1712 (a 12x4x2 cm approximately black box).
To acquire a diffractogram click File> Acquire or the
same time. The following 13.2 screen appears:

button. The order File> New is executed at the

Figura 13.2.
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The File menu

New. It allows to begin a new data collection from the diffractometer. It is equal to the New button.
Sample file. It allows to select a file where the diffractogram will be saved. The format of the data is the
same as the one that is shown in the example. It is equivalent to press the

button.

Go. The data collection begins under the conditions that have been set up in the rest of the screen (Start
angle, final angle, etc). It is equivalent to the Go button.
Load setup file. It loads a configuration file with the CNF extension. When accessed to this screen the
configuration file loaded by default is DEFAULT.CNF. This order is reserved to configure the data collection
in agreement with a model (start angle , exploration type, goniometer speed, final angle, etc.) which is used
for a certain purpose (identification of mixtures, unit-cell refinement , OA, etc.). These configurations are
defined by the user.
Save setup file. A configuration defined by the user is saved with the CNF extension (it carries out the
inverse operation to the previous point).
Main. XPowder returns to the main screen. It is equivalent to the

or Main button.

The Diffractometer Menu

Terminal. It shows a small screen to can dialogue with the diffractometer. It is equivalent to the keyboard
and screen at the diffractometer control panel, but as remote terminal. The commands are sent by
Command window and the answers of the diffractometer appear in Response window. The History
window contains the whole conversation. Tuning button can be used to obtain a graphic of static measures
of intensity at the current 2 angle in instrumental setting processes.

 angle of the diffractometer to the beginning
symbol of the diffractometer system (for

The keyboard return moves the
position. Response shows the
example C =).
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The Quit button closes the remote terminal.
Comm diffractometer setup. It establishes the communication parameters between XPowder and the
diffractometer. These parameters have to be established in the communication plate of the diffractometer by
leaving the microswitches in the appropriate position (see the technical manual of the communication plate)
and they should be the same in both the diffractometer and the computer. In case of problems try to modify
the parameters of XPowder until they match those of the diffractometer. Frequent combinations are:
9600, N, 8,1
4800, N, 8,1
9600, N,7, 2
etc.,
The port of the computer usually is Com1 or Com2.
Once the communication is established (it can be proved with Terminal) save this configuration (Save
setup file ). It can be edited latter with a text editor (Note Pad for example) with the name DEFAULT.CNF.

Pulse height analyzer. It establishes the minimum and maximum levels of the pulse height of the
discriminator diffractometer counter. These parameters should be adjusted previously in the diffractometer
(consult the technical manual).

Wavelength. It allows to selecting the wavelength or the X-ray tube installed in the diffractometer.

Figura 13.3
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Setting the experimental conditions
Recording mode
There are two modes of data collection. The first one moves the  angle of the diffractometer at
continuous speed and the counts are accumulated by the counter at certain intervals (integration mode).

The second mode consists of measuring statically during a certain time in a fixed  angle while the counts
are accumulated. This operation is repeated at the next  angle and so on until arriving to the final 
angle (static mode). Naturally both recorded modes are carried out in automatic mode.
The first one produces softened profiles, but also a small deformation and stretching in the peaks. The
second one is more accurate and it doesn't deform the profiles, but it produces more random noise.
The first mode can be improved by diminishing the exploration speed. The second mode can be improved
by increasing the integration time.
To select the integration mode, press the Continuous option button. To select the static mode press the
Static button. Goniometer rate box marks the angular speed of the goniometer. Integration time box
marks the time during which the counter accumulates counts and 2-theta step box marks the increment of
 angle between two successive measurements. Only the boxes that can be modified are actives.
Exploration interval. The initial  angle is entered in the Start box and the final  angle in the End box.
The starting time and the recording time appear in the text box:

Diffractogram capture. Press the Go button when the experimental conditions have been set up. The
diffractogram capture can be stopped at any moment (Stop button). A continuous re-scale of the intensities
axis as a function of the maximum of counts is done during the data collection.
Data format. The diffractogram data are codified in ASCII text. The experimental conditions are set up in
the first fifty lines. The first line is a heading with free format, consist of a key word(s) (Step size = for
example) and an argument (0.040 in this same example). Empty lines can be numbered to identify their
position (line 41 for example) and the line 50 is “Data” to indicate that next lines corresponds to
experimental measurements. Data are written in two columns separated by one or more spaces. This
format guarantees that the data can be interpreted by any user and read or imported by any program in any
operating system. Lines begin with Line keyword are ignored.
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Example:
XPowder diffraction software. PLV file format Ver. 3.0
Sample= AFRICA.PLV
Site= Universidad de Granada (Spain)
User= Crista-Mine-Gr
Date= 28/10/2003
Time= 13:06:15
Start 2-theta scan= 10.000
End 2-theta scan= 80.000
Step size= 0.040
Scan mode= Continuos
Integration time(sec)= 0.4
Anode= Cu
Filter= NO
Monochromator= Graphite 2Ý
K-Alpha 1=

1.54051

K-Alpha 2=

1.54433

Ka2/Ka1 Ratio=
K-Beta=

0.5

1.39217

Automatic sampler changer= NO
Single Gobel mirror= NO
Divergence slit= AUTOMATIC
Receiving slit= 1/0.1/1
Generator voltage(Kv)= 40.00
Tube currrent(mA)= 40.00
Maximun counts=
Line

26

Line

27

Line

28

Line

29

Line

30

Line

31

Line

32

Line

33

Line

34

Line

35

Line

36

Line

37

Line

38

Line

39

Line

40

Line

41

Line

42

Line

43

Line

44

Line

45

Line

46

Line

47

Line

48

Line

49

10

Data
10.000

4

10.040

5

10.080

10

10.120

8

10.160

7

10.200

5

10.240

10

10.280

9

10.320

10

10.360

11

10.400

6

10.440

11

10.480

7

10.520

6

10.560

9

···

···

···

···

···

···
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Setting the  angle zero mark. It can be carried out automatically by recording the diffractogram of a
well-known standard (for example, silicon) or with an internal standard. XPowder allows to use the list of
the std.txt file for this purpose. The following procedure should be performed:.
1.

Select the standard from the list as shown in the image.

2. Record the diffractogram.
3. With the left button click on the symmetry line (or on the maximum) of a well-known pick from the
diffractogram.
4. With the Alt + left mouse button click near the position of the standard line to which the maximum
must be adjusted. The true  angle can be input manually in the True angle box. If this is the case
step 1 it is not necessary.
5. Press the Fit button and then the diffractometer corrects the zero offset automatically.
To observe the quality of the adjustment, mark the Match check box before pressing Fit. Then, the
diffractometer measures automatically the standard again.

Recording strategy. When selecting the Single diffractogram option button, the files of each recording
should be named one by one. Whit this option, a file name should be selected before recording each run in
order to save the recorded data Figure 13.4.

Figura 13.4
f the option Serie is selected, the samples are named by adding an order number to the original file name.
For example, if the name is example the program will output the files example_001.plv, example_002.plv,
etc. It is necessary to press Go between successive diffractograms.

If the Cycle option is selected, the number of recordings selected in the box Max scan number will be
carried out automatically (10 in the example) with the time delay input in the Delay (minutes) box (30 minutes
in the example). The name of each file follows the same rules as in Serie. This mode is used to study
changes of phases, hydration grade, crystallinity, etc. It is also used coupled to changes in temperature. The
maximum number of diffractograms is 999 and the delay time betweendiagrams can be set to zero (without
wait) or as long as desired (always in minutes).
If Selected profiles is checked, we can select individual reflections in order to be secuencially scanned (figure
13.2, 2-theta scan profiles).
It can be selected also:
 Automatic sample changer: Include in ‘Default.cnf’ the line
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AutomaticSamplerChanger = PW 1775
or
AutomaticSamplerChanger = PW 1775


Spinner: Include in ‘Default.cnf’ the line
Spinner= PW 1774
or
Spinner PW 1774



Graphic recorder: Include in ‘Default.cnf’ the line:
GraphicRecorder = PW 8203A
or
GraphicRecorder = PW 8203O

Home
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Updates
th

Version 2004.04.49. (11-05 -2008)
1. Starting with this release of the program , the searching do not necessarily uses the full diffractogram, as
explained in Chapter 2, but is restricted to the selected  interval. This allows you to search unique
reflections on isolated so comfortable.
For example, a residual reflection, which on a previous search has not been assigned to any component, can
be selected to complete the list of identified phased. The modification of the program is useful in samples with
minority components or or poor crystallization.
2. It has removed the check box Force subtraction in the tool 'Matching', Chapter 5, which now stays as in
Figure A.1.

Figure A.1.
Now, the subtraction component option appears as in Figure A.2, after it has calculated the pattern record
with the order Card profile .

Figure A.2
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th

Version 2004.04.50. (11-10 -2008).
File extensions' .asc 'and' .xy ', in addition to the classic ".txt" for text file formats (XY), which already existed
in the early versions of XPowder, have been included again.
th

th

Versions 2004.04.53. ( 01-08 -2009) and 2004.04.54 (01-14 -2009)

Many researchers record their diffractograms in limited angular intervals (eg explore 2 between 5º and 45º).
It is common for example in studies of the clay minerals or when used portable diffractometers without mobile
components. However databases (PDF and AMSCD) contain information on crystalline phases patterns
registered outside the limits explored in laboratories. Thus, some recods contain only d-spacing greatest 3.00
Angstroms while others (especially the most modern) contain information that goes lesser to 0.7 Angstroms.
In order to optimize the search conditions of crystalline phases, users can now instruct the program so that
unused 2 zones are excluded from the databases. This can be done at the time of the option to install
Database Install or Update XPowder in XPowder homepage. The searchings are made with much greater
speed and safety because only the ranges of records that best matching in the respective laboratories are
used for adjustments.
The values for angle interval of database can be entered in boxes Higher d-spacing and Lower d-spacing
in Figure A-3.

Figure A-3. The program will exclude d-spacing lesser than 0.94 Angstroms and greater than 70 Angstroms
during the installation of the database AMSCD.

Angular areas excluded from the database appear in the framework Database and are drawn with a gray
background in Advance searching tool (Figure A-4).
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Figure A-4. During the searching, the program does not take into account the d-spacing of the database for
higher values of 2 = 110.06 ° (grey zone). In general, this area is not used for identification of crystalline
phases. To use it, would have to reinstall the database with value 'Lower d-spacing' of 0797 Angstroms, which
corresponds to approximately 150 ° for radiation CuK  .
Since version 2004.04.54 has been including in Matching criteria frame, a new approach 2 reflections
that uses only two of the diffractogram reflections to matching with the high intensity reflections of database
records. When this option is used, the number of possible solutions is high in general, due to the lack of
information used in the calculations. It is therefore appropriate to provide supplementary information to the
program (about chemical composition, for example
). This approach should be used in diffractograms
having small scanning intervals (eg 2 <2° <50, or to identify minority phases. Also, from version 2004.04.54,
the second searching options of 'Desperate' has been renamed to '1 reflection' , because it uses in searching
only one reflection.
To find the database records that match a single reflection of experimental pattern, this reflection should be
exclusively selected by the zoom and then click Search or Add . The searching option '1 reflection' will be
changed by the program itself and then it carries out the automatic searching.
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th

Version 2004.04.57. (02 - 11 -2009)
1. The new tool Matching is more powerful (Chapter 5).

Figure A.5. This tool replaces the one described in A.1
2. More choices and better options for quantitative analysis with experimental standards (Chapter 7 and PTT)

3. Three new data formats are recognized directly by XPowder:

-

The ascii dataformat ‘*.X_Y’ of the diffractogram file output of PowderCell programs of W. Kraus &
G. Nolze (2000). Federal Institute for Materials Research and Testing. Rudower Chaussee 5, 12489
Berlin, German) .

-

Sietronic ‘*.cpi’ format.

Index

‘*.nja’ de Seifer.
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XPowder 2010.01.10. New features. (May, 2

1. Reloading of previous session patterns.

th

2011)

Clicking on the picture of the mineral (beryl) of the home

screen, reloads all diffractograms of the last working session, but calculations are excluded (searchingmatch, quantitative, etc. ) .

2. Reloading of previous analytical results…

Retrieves the previous analysis (historic) carried out on

those XRD patterns that are currently in XPowder memory (searching-match, quantitative, etc. ). Like other
parts of this program, the large button retrieves data from the active sample, while the top bar performs the
same action on all loaded XRD patterns.

3. Homogenization of 2 scan intervals and steps.

Standardizes 2 angles (initial, final and steps) for

all those XRD patterns loaded. This action is performed even if the initial data formats are quite different.
The order is also available in 2D and 3D stacking windows. The range is homogenized using the higher initial
2values, the smaller final 2 values and the minor 2 interval. When some diffractogramme has the scan
step variable, data are converted into constant step (histograms). Occasionally, when the initial data are too
heterogeneous, this command may need to be run twice.
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4. Linear and nonlinear  zero shift. By clicking button



4.1. Customize lineal shift (See Chapter 3)



4.2. Pair method (See Chapter 3)



4.3. Planar CCD geometry



4.4. Polynomial 2 fit
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, four options are availables:



4.3. Planar CCD geometry: This nonlinear correction is used with flat detector diffractometers
where the sample position can not be fitted accurately. Requires knowing the approximate
distance between the sensor and the sample, and the angle between sensor and X-ray beam.
Can be used either one reflection standard (True and Observed boxes and Compute) or the
Customize cursor to move the diffractogram to the correct position

Prior to correction:

After correction:
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Planar CCD geometry correction details:

O = Diffractometer centre (ideal sample position)
S= real sample position
 = 90º - Sensorangle
Z= Axis Z length. Distance between O and CCD along primary X-Ray beam
X = Coordinate along Axis X
 = Displacement of diffractometer center (“Depth”)
2o = Observed (measured) 2
2 T = True 2
2correction in function of ‘depth’ X-Ray penetration (= sample offset along primary X-Ray direction)
 is a know or estimated data
In OHC triangle, by using sine theorem:
Sin2o/ X = Sin / V = sin / Z
 = 90º - Sensorangle
V = X · Sin / Sin2o
[1]
X = Z · Sin2o / sin  o
X = Z · Sin2o / sin (o) 

In OHS triangle, by cosine theorem:
t2 = 2 + V2 – 2  V · cos 2o
[3]
And by sine theorem :
Sin  / V = Sin2o / t
Sin  = Sin(-2T) = Sin2T
Sin2T = V/t · Sin2o
[4]
By replacing V [1] and t [3] in [4]

Sin2T = (X · Sin 2 + V2 – 2  V · cos 2o )½
Where V and X are calculated by [1 and [2]
 is the sample offset along primary X-Ray beam direction in equal units of axis Z.
This formula let to correct the deformation of 2scale of any diffractogram obtained from CCD.can be estimated
from a reflection standard (see next page) or by a cursor changing value while the new diffraction pattern is
matched.
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Calculation of ‘depth’ X-Ray penetration (= sample offset along primary X-Ray direction) from a standard reflection
2T - 2o are know data
In OHS triangle, by sine theorem:
Sin  / V = Sin2o / t = Sin  

2o 2T) - 2o = 2T - 2o

[6]


On the other hand:
Sin  = Sin2T
[6 ] can be rewrited:
Sin T / V = Sin2o / t = Sin 2T - 2o/

Turn out :
 = [V · Sin 2T - 2o/Sin T

[7]

Where:
V = X · sin  / Sin2o
[1]
X = Z · Sin2o / sin( –2o)
[2]
= (90º - SensorAngleº)
Z = axisZ (distance from ideal simple position to CCD along X-Ray beam direction)
Then:

 = [Z · Sin·Sin (2T -2o/ Sin ( -2O·Sin T ]
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4.4. Polynomial 2 fit. This algorithm has general character and allows any non-linear adjustment
of the angle by using a standard sample and a polynomial of degree up to 9 maximum. This
method can be used instead of 4.3, but requires an examination of reflections of the entire
2angular scanned range.

Prior to correction:

After correction:

The observed and expected data they can direct entry into the table, or can be placed in an archive with
‘.T_O’ extension, created with a text editor (use Open std and Save std):
Example of ‘T_O’ archive:
Head (any)
20.323 20.800
25.880 26.600
35.415 36.510
38.331 39.390
39.120 39.420
41.178 42.410
44.334 45.700
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5. Customized databases. An unrestricted number of custom databases can be used. The generated files
have the extension MYD and they can be installed at any time on various computers, just like any other
database. The procedure to build and to maintain a custom database is:

5.1. Load an experimental pattern and optionally make the identification of the crystalline phases.
5.2. Click button
custom database.

of the tool ‘Results’ in order to add the current card from an existing database to a

5.3. Alternately, select the reflections of crystalline phase of experimental diffractogram by clicking on
pattern reflections. Then, push on button
of main menu to add the experimental current Bragg’s
reflections as further card into an existing database. Optionally, you can export crystallographic data (unitcell, hkl, etc) from previous database ( ) or write directly into text boxes. The default phase name is the
sample label, but it can be usually modified.

119

5.4. Select the destination customized database (a preexisting or a starting custom database).
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5.5. If a new database is selected, rename it and push _OK_ button:

5.6. _Add_ the new card (Jarosite_Rio Tinto in the example) to the custom database (Sulfates [70-1.94] in
the example).

Note: The index files of each database are placed in the directories:
Program Directory\ DBlog\DB_x
Where x are sequential integers for all databases . The value x=0 is reserved to the starting
‘MyDatabase.myd’.
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6. Rearranging diffraction patterns
This tool is very helpful to change the relative position of the diffractograms in 2D or 3D clusters.


On the ‘Home screen’ push the right button in the mousse and select ‘Files/Sorting patterns’.



On the ‘Stacking screen’ push the right button in the mousse and select “Sorting files’.

Drag the file with the left mouse button to the new position.

Home
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XPowder12
New features.
Ver 2012.02.01.






















General index

Powerful K stripping function.
Import additional diffractogram formats, including the direct conversion of Chemin
diffractometer images of Curiosity Mars Rover of the MSL project to (x,y) text
files.
File reports in Adobe pdf format.
Ability to save and restore complete work sessions.
Display of partial components in full-profile quantitative analysis.
A new tool allows continuous zooming into diffractograms, both laterally and
vertically.
The databases installed previously with the old program XPowder can be used
directly.
Search-match, quantitative analysis, 2 correction and profile tool are more compact
than in the old XPowder program.
In quantitative analysis with XPowder12 program, the acronym PIR (Pattern
Intensity Ratio) is used instead of the old RIR (Reference Intensity Ratio),
because this term is usually calculated from a single reflection (the highest value
in each phase divided by the highest value of a standard, i.e. corundum).
However, both programs use the concept PIR, which is far more accurate.
The window program size can be easly scaled.
A new fast method for full-profile quantitative analysis of components using ‘Dirac’
patterns, convolution and PIR scale factors.
XPowder12 give access to the free database P2D2 (Download: Predicted Powder
Diffraction Database). XPowder12 compiles directly this database, when text raw
files are installed.
Additional background subtraction method.
Area under selected zone.
Bruker RAW patterns
Critical Update. Database Color Patterns
Excluding elements from the periodic table in search-match.
Version 2004.04.35
XPowder and XPowder12 can be used simultaneously. In this case it is
preferable to install the programs in two different folders.
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XPowder12 home screen

Figure 12.1. Home screen of XPowder12. The picture logo can be modified by including
a line of the type ‘Logo = Path_picture’ in the ‘Xpowder12.ini’ file. Alternatively, the logo
picture file named ‘Logo.jpg’ in the folder XPowder12 program can be replaced by any
other picture.

Figure 12.2. Up to fifty XRD patterns can be loaded simultaneously using the ‘File’ menu.
In the figure the basic functions are shown. Sophisticated data analysis tools appear when
clicking the button ‘Expand’.
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Figure 12.3. Main commands in the expanded ‘Main menu’ of XPowder12 program.

Figure 12.4. Dialog box for modifying diffractogram display settings and selection of the
database to be used by data analysis tools.

125

SEARH and MATCH

Figure 12.5. Advanced searching tool (above) and basic results display below).
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Figure 12.6.

Expanded results display.

Figure 12.7. Boolean searching. In the example, every hydrated carbonate of the selected
database will be added to the list, when the blue arrow button is pressed.
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QUANTIFICATION USING DATABASES

Figure 12.8. Quantitative analysis based on database records. Basic functions.

Figure 12.9. Quantitative analysis based on database records. Expanded functions.
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QUANTIFICATION USING EXPERIMENTAL PATTERNS

Figure 12.10. Tool for quantification using experimental standard patterns.

Figure 12.11. Quantification using the experimental standard pattern tool and results display
(Note ‘differences’, ‘components’ and ‘calculate’ display options).
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Program window size
The program window size can be easily modified including the two following lines in the
‘XPowder12.ini’ file:
HeightScale
WidthScale

= ‘heigh scale factor’
= ‘width scale factor’

Where both scale factors may vary between 0,6 (60 % size) and 1 (full screen size).

Figure 12.12. The example correspond to values of HeightScale= 0.8 and WidthScale=

0.9
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Transformation of 'Chemin' diffraction images to (x,y) text files

To access these functions simply open the image from the main menu:
File > Open /Select CHEMIN Images/ graphic file (*.TIF, BMP,JPG, etc).
The image of the diffraction spots is displayed as in Figure 12.13. Also, the initial
parameters that define the width, height and sample-CCD distance which are included in
the file 'XPowder12.ini', are shown in the top right of the screen. The initial coordinates
of direct beam are referenced to the top left corner of the CCD. All units are in pixels
and the values can be changed manually during the program execution. Additionally, some
of these values, such as the coordinates of direct beam and the distance to the sample,
can be tuned with various program tools.

The following actions may be performed:
1. Centering of the direct X-Ray beam on CCD.
There are three available methods (figure 12.13):
1.1. Select ‘Customized centering beam’ (Focusing manual). It is only necessary
to press the proper point. This method lacks precision, but can be used as a preliminary
starting point.
1.2. Auto Center button. It usually works well, especially if you use previously 1.1.
1.3. 'Centering ring'. When the option is selected, just click on any ring and it will
focus on the direct beam. This is the most accurate method.
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Figure 12.13. Diffraction image and main commands and features of the graphic tool.
The quality of the focus can be tested by pressing the button ‘Rings’ (figure 12.14).
After having centered the direct beam it is
advisable to mark the button 'Main image zooming
and dragging' to prevent the X-Ray beam center
from accidental modification. Furthermore, this
option allows you to move and zoom the image
with the left mouse button and mouse wheel
respectively.

Figure 12.14. Checking quality of the focus with
the button ‘Rings’.
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2. Computation of (X, Y) data.
(X= 2o, Y= Accumulate counts at the ring of radius 2o).
The calculation is done with the buttons ('Preview' or 'Go’, See figure 12.14). Several
options can be used:
2.1. ‘Partial circles correction’. Fix the breakdown of the circles outside the
boundaries of the CCD (recommended).
2.2. ‘1/sin(theta)’ correction. Create a diffractogram as obtained from BraggBrentano geometry and automatic slit (recommended).
2.3. ‘1/tan(theta)’correction . This action computes an diffraction pattern similar to
the previous one.
2.4. Background subtraction.
The 2 limits and the 2 step of the output diffractogram can be selected, as well as
detector width, length, distance, tilting, etc of the device. Alternatively, ‘Terra’
diffractometer geometry can be used (button ‘Terra’).
The ‘Go’ button sends the calculated diffractogram to the main screen (figure 12.15.).

Figure 12.15. Computed diffraction pattern obtained from figure 12.13. containing K
K + K peaks. Background has been subtracted and intensities have been divided
sin, according to instructions of figure 12.14. In most cases, as in the example, it
necessary to remove the K (figure 12.17) and K(figure 12.18) components

using the commands of home menu (See figure 12.3.).
Figure 12.16. Pattern after having Stripped K (
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in home screen).

+
by
is
by

Figure 12.17. stripping
( in home screen). The (IK: IK1) relation can be
tuned with the vertical scroll bar of the figure. Original pattern shows in grey and stripped pattern shows in red. Final 2 zone trace, in green, is unavoidably excluded
from computation.

Figure 12.18. Pure K pattern
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Figure 12.19. Applying One-Click searching on pattern from figure 12.17. The results list
shows the beryl records of the database (AMCSD).
Home
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New Quantitative Full-Profile

XPowder12

A new fast method for full-profile quantitative analysis of
components using ‘Dirac’ patterns and convolution
XPowder12 ver 2012.02.02 or later.
This method consists on fitting full profile diffractogram to their components, either
experimental or calculated by least square statistical methods, or simulated annealing.
Additionally, PIR scale factors are used.
Where the components are calculated, they can be obtained from an experimental
diffractogram of a highly crystalline pure compound, or one theoretical type ‘Dirac’ (see
below). These diffractograms are referred to as ‘starting pattern’ or ‘stick pattern’.
A ‘model diffraction pattern’ deconvolution with the ‘starting pattern’ is used to obtain the
appropriate ‘function filter’ in order to obtain the final ‘broadening pattern’ of individual
compounds. The ‘model diffraction pattern’ may be, for example, the diffractogram of any
sample recorded in our laboratory.
The final ‘broadening patter’ of each component is then obtained by the convolution
product of the ‘stick pattern’ with the ‘function filter’. Optionally, you can add the Caglioti
broadening equation and/or correction for K2 inclusion.
This ‘broadening pattern’ allows obtaining high quality quantitative analysis very quickly, as
explained in detail in the attached example.

XPowder12
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Quantitative Dirac…

(February, 3thStick
, 2013)patterns

generation in PLV format.
XPowder12

Quantitative Dirac…

These files contain all data from a diffractogram, including the beginning angle, step,
lambda, etc. All the intensity values are zero except for those corresponding to 2 angles
of the d-spacing of any phase (figure A1).

Figure A1.
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The ‘Dirac’ button lead to generate these diffractograms from any card of an existing
database (figure A2), or calculated from the space-group and unit-cell parameters
(figure A3), or from the principal menu (Save File As…?, Figure A4 ), the selected
values in an experimental diffractogram can be also saved in this special format also.
Optionally, the corresponding to K y K reflections could be included.

Figure A2.

Figure A3.

Figure A4.
These kinds of files could be used to simulate
realistic experimental diffractograms of pure
phases by convolution with distribution functions
(Gauss, Cauchy, Pseudo Voigt, Pearson VII),
asymmetry and FWHM computed by Caglioti equation.
XPowder12
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Quantitative Dirac…

Broadening profile generation
Broadening profile generation from external diffraction pattern model
XPowder12
Quantitative Dirac…

Figure B1. Initial filter (left, red) and ‘Dirac’ (purple) patterns.

This tool, located in the principal menu ‘Tools’ (Figure B1), allows creating any
pragmatic theoretical profile by the modification of FWHM values, the Gaussian/Lorentzian
components, the Pearson VII exponent and the asymmetry. If the ‘Display’ box is
checked, the convolution product of this filter with the current experimental diffractogram
will be displayed. The small screen on the right shows (in purple) the original
diffractogram, Dirac in this case, on the selected 2 interval.
When the cursor is positioned on the upper-right corner of the graphic, ‘magnifying glass’
and shift arrows are shown (figure B2). They allow us to focus and to shift the 2
interval of the chosen reflection respectively.
The adjustment of the function filter can be done both manually, using the cursor
(FWHM, Gauss, etc), and (or) automatically through an experimental or theoretical
diffraction pattern model. This model can be any sample belonging to a batch that
becomes capable of being quantified, and whose diffractogram has been recorded on our
diffractometer.
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Figure B2. Initial filter (left, red), Dirac (purple), experimental model (grey) and
preliminary convolution (green) patterns.

The tool ‘Upload model’ lead to load this model (in grey at figure B2) and adjust the
2position by ‘Model zero shift’ arrows.
The ‘Fit’ button is now available and allows obtaining automatically the correct filter
function (red on the left of B2 figure). Equation [2] lets achieve the final pattern C
(green in figure B3) by convolution with the principal ‘Dirac’ diffractogram (purple in
figure B2). It would simulate the experimental conditions (including even the instrumental
function as the sample parameters). The program uses ’simulated annealing’ methods, by
the minimization of the R-Acc value, defined in the classic way.

R-Acc =

i

wi (Io-Ic)i/i wi Io

[1]

Where,
I = Counts of each pattern point (i), o = Measured counts, c= Calculated counts,
w = Statistical weight

The figure B3 shows the fitted final convolution product C in green.
C=A*B

[2]

Where
A= filter function
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B= Theoretical diffractogram (Dirac) or experimental high crystallinity X-Ray pattern.
C= Final diffractogram fitted to the experimental lab conditions (grey).
The grey profile corresponds to any sample of our routine at the lab. It could be
observed the concordance of this profile with the C calculated and the final R-Acc value
(= 0.03073) enough small.

Figure B3. Clicking on ‘Fit’, the final broadened profile is computed. Notes R-Acc value
(= 0.03073).
The button ‘View’ show the result of the convolution product in the principal screen as
well.
The calculated diffractograms (C) could be saved (Save) including Caglioti FWHM
adjustment and K2 inclusion if case. Caglioti equation [3] parameters can be modified
and edited in the tab ‘Editing Caglioti parameters’ (figure B4). For setting the initial U,
V, W, P parameters, the ‘pattern model’ can be used as in chapter 11 of the XPowder
user guide.
Now, the full calculated diffractograms (C) could be saved (Save) including Caglioti
FWHM adjustment and K2 inclusion, if case.
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Figure B4. Caglioti functions for sample and instrumental profile. Small circle shows the
position of the current profile.

The function to be applied on the calculation of the broadened profile is drawn in red.
The small circle shows the position of the current profile used as a model for obtaining
the convolution filter. The parameters U, V, W and P can be changed manually using
the arrows ( in ‘Sample/FWHM’ column). This action continually redraws the function.
It should be noted that the change on the parameter W lets move the curve vertically,
along the ordinate axis.

Caglioti equation:

B2 = U · Tan2 + V · Tan + W + P/Cos2

[3]

(The values of U, V, W and P are calculated to express B value in 2 radians.
However this value is shown in the graph as 2 degrees).
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Figure B5

By this way, the theoretical diffractograms of Aragonite_Broad, Calcite_Broad,
Celestine_Broad & Dolomite_Broad have been obtained and appear together with the
diffractograms of experimental samples (F1, F2, F3, F4 y F5) and another one
corresponding to the average (Figure B5). Now, the experimental samples may be
quantified in terms of its theoretical component patterns.
XPowder12
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Quantitative Dirac…

Extended practical example of uses of ‘Dirac-Convolution’
broadened diffractograms for accurate full-profile quantitative
analysis of components.
XPowder12

Quantitative Dirac…

The examples to be used here are located in the ‘Samples\QuantitativeExample’ directory
of the program. PIR scale factors are also calculated. It is recommendable for the user
to check the following steps:
C.1. Upload diffractograms: F1, F2, F3, F4 & F5.
C.2. Identify the phases of any sample (F5 in the example)

Figure C1
C.3. In Figure C1, Expand the tool and calculate ‘Dirac’ diffractograms for the components
(‘Calcite_Sticks.plv’, ‘Dolomite_Sticks.plv’, ‘Aragonite_Sticks.plv’ and ‘Celestine_Sticks.plv’).
The
options ‘No’, ‘Mediate’ & ‘Maximum’ refer to the fitting between intensities of the experimental
diffractogram (0, balanced, maximum respectively) and the database contained. In the example,
the Mediate option is used.
C.4. Upload on turn the four components diffractograms (‘Calcite_Sticks.plv’, ‘Dolomite_Sticks.plv’,
‘Aragonite_Sticks.plv’ y ‘Celestine_Sticks.plv’), to apply in each of them the convolution filter and
save the respective filtered diffractograms as in B. Thereby create the new patterns with suitable
profile
broadenings
(‘Calcite_Broad.plv’,
‘Dolomite_Broad.plv’,
‘Aragonite_Broad.plv’
y
‘Celestine_Broad.plv’).
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Ideally, this is explained by only using the ‘Dolomite_stick.plv’ pattern.

C.4.1. Select one isolated reflection of dolomite_stick (30.48 <2<31.43) in blue
in the example
C.4.2. Upload model (e.g. sample F5, grey in Figure C2). It is advisable to use
a model in which the background has been subtracted before. In the example the original
sample without any modification is used. In some case, it might be necessary to modified
by hand the zero of the model using ‘Model zero shift’ tool.

Figure C2
C.4.3. Click ‘Fit’ in order to calculation of broadened pattern. The result appears
in green on figure C2 with R-Acc = 0.03298.
C.4.4. ‘Save’ -> (‘Dolomite_Broad.plv’). The full final pattern is on figure C3.
Figures C4 and C5 show other patterns involved in the example.

Figure C3.
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Figure C4. The figure shows the individual XRD patterns of the components, both initial
(Sticks) and final (Broad).

Figure C5. The figure shows all the patterns involved in the procedure. F1, F2, F3, F4,
F5 are the samples to be quantified. ‘Xxxx_Broad’ are the broadened patterns of
components. ‘Xxxx_Sticks’ are the ‘Dirac/d-spacing’ pattern components.

C.4.5. Now, you must create a list within the standard patterns in the quantitative
tool, using ’Examine’ for each phase, as in figure C6. At the end, it is necessary to
save this list with any name (eg ‘ListOfPhases.LST’).
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Figure C6. Quantitative tool: Building a list of standard patterns.

Figure C7. Preliminary quantification ignoring scale factors (RIR, PIR, I/Iref in other
authors of places this manual user). All scale factors are set to 1.

C.4.6. Now, we carry out a previous quantitative analysis of a known composition
sample (it could be created artificially), marking the ‘Ignore Scale factor’ cell. It could
be done for any normalization criteria. In the example is used the statistical criteria
‘Height’. Optionally any other criteria could be used (Area or None).
C.4.7. Results of preliminary quantification are showed in the figure C8. Optionally,
the experimental sample could be showed together with the partial components (with
different colors), differences (no in the figure C8) and calculate diffractograms (grey
circles). The determination error is expressed by parentheses, just after each percentage,
and it affects to the last significance numbers.
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Figure C8.
Quantitative decomposition of phase components in experimental sample
Sum5. Circles are the calculated pattern.
C.4.8. Now is necessary to calculate the scale factors (PIR= Pattern Intensity
Reference) by an easy calculation:

PIR= (X1P/X1S)· (ES/EP)
Where,
X1P is the
X1S is the
ES is the
EP is the

%
%
%
%

of the phase
calculated for
known of the
in the known

[4]

used as reference (the most stable of the group)
each one of the rest of the components
reference phase
weight of every one of the other components.

Obviously, the PIR value for the reference phase (‘celestine’ in the example) is ‘1’ in
all normalization criteria cases. However, it can be seen that an external weighed
standard (like 10% corundum, 15% quartz,…)that allows application of these factors to
extend to samples with different compositions can be added to this sample of known
composition.
Take into account that the reference component could be added artificially to all samples
(for example a 5% in weight). This allows the final quantitative analysis without the
necessity of fitting the total to 100%.
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In the last three columns on the chart of the following calculation, the PIR factors
calculated by the three normalization criteria are reflected. The inclusion of the
complementary data Rho and Mu (in figure C6) allows the absorption corrections and
the media theoretical density calculation of the sample (no here).
Table C1.

S = Standard, P = other phases
X(with 'Ignore Scale factor')

Real % weight

Height1

Area1

None1

E (% , mg, etc)

cm2·g-1

g·cm-3

cm-1

Height

Area

None

Aragonite

10.50

39.70

49.80

20.50

53.4

2.927

156.30

0.45

0.56

0.85

Calcite

98.60

45.80

89.00

35.30

63.9

2.711

173.23

2.46

0.37

0.88

Celestine (Standard)

26.00

79.90

65.70

22.90

79.2

3.978

315.06

1.00

1.00

1.00

Dolomite

75.00

33.50

76.60

21.30

46.9

2.863

134.27

3.10

0.45

1.25

PIR= (X1P/X1S)· (ES/EP)

Complementary data

PIR

FINALLY, THE PIR NORMALIZED SCALE FACTORS IN THE MODEL (FIGURE C6)
MUST BE INTRODUCED AND THEN THE LIST HAS TO BE SAVE AGAIN AS IN C.4.6.
THIS LIST WOULD BE USED AT ANY TIME TO ANALIZE ANY NUMBER OF SAMPLES
IN 50 SAMPLES GROUPS. TO INDICATE THAT THE MODEL GENERATION COULD
SEEM COMPLICATED AT THE BEGINNING. AT SOME POINT THE USER WILL REALIZE
THAT IT IS NOT.
This list can be used in AUTOMATIC MODE (AUTOQUANTITATIVE). To do this you need to edit the file
and enter the lines:
[Standard quantitative]
StAutoQuantitative= c:\xpowder12\ListOfPhases.LST
StQuantitative_StEnabled= True
(or False case NOT AUTOQUANTITATIVE)
You can also do this from the program (Use ‘Set autoq’ button of figure C9)

Figure C9.

Final model is completed. Now, all samples can be routinely analyzed one

by one way (

) or in clusters ( ) of up to fifty.
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THE CREATED MODEL IN THE EXAMPLE HAVE BEEN DONE IN HALF AN HOUR
APROXIMATELLY AND NOW IT COULD BE USED AFTERWARDS, AT ANY TIME, IN A
CONTINUATED WAY IN INDUSTRIAL CONTROL PROCESS, MINNING AND QUARRING,
BASIC INVESTIGATION, ETC.
The output of results can be saved using ‘File/ Save Log File as TXT’ on home
screen.
Also, it can be saved as PDF using
button for current sample).

(upper bars for all upload samples, lower

The table below shows a part of the report generated for the samples analyzed here. All
these examples are incorporated diffractograms of the program
(\XPowder12ProgramDir\Samples\QuantitativeExample).

Table C2
Sample * ARAGONITE CALCITE

CELESTINE DOLOMITE

Rho(g.cm-3)

Mu(g-1·cm2)

Rint

Cycles

Sigma_

F1

* 19.7(0.2) 39.7(0.3) 20.0(0.3) 20.7(0.4) 0.000( 0.000)

0.000

0.01257

2

0.00097

F2

* 17.2(0.3) 33.2(0.4) 31.8(0.3) 17.8(0.5) 0.000( 0.000)

0.000

0.01497

3

0.00104

F3

* 15.7(0.2) 52.3(0.3) 13.7(0.2) 18.3(0.3) 0.000( 0.000)

0.000

0.00940

2

0.00092

F4

* 25.5(0.5) 22.4(0.8) 41.8(0.5) 10.4(1.0) 0.000( 0.000)

0.000

0.02629

3

0.00136

F5

* 22.6(0.2) 30.4(0.3) 06.5(0.2) 40.5(0.2) 0.000( 0.000)

0.000

0.00915

3

0.00089

Sum05

* 20.5(0.2) 35.3(0.3) 22.9(0.2) 21.3(0.4) 0.000( 0.000)

0.000

0.00930

3

0.00090

Sum fitted 100%. The percentages have been calculated weighing data. 2-theta angles have been refined
Normalization criteria: Max. counts = 1

XPowder12
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Quantitative Dirac…

P2D2 DATABASE
Predicted Powder Diffraction Database
The P2D2 (Download: Predicted Powder Diffraction Database) is built up by calculating
the powder patterns corresponding to the predicted crystal structures from the latest PCOD
update. The job is done partly by ZEFSA II (898707 entries) and for the GRINSP data
(163520 entries) by the CIF2POW software. The P2D2 database currently includes
twelve text files, each with approximately 100000 compounds, which can be automatically
indexed by XPowder12, individual or jointly.
These files are:
Zeolites BKS data (Two different clusters can be created, each containing three BKS files)
P2D2-BKS01.txt
Tetrahedral only (100000 entries each)
P2D2-BKS02.txt
P2D2-BKS03.txt
P2D2-BKS04.txt
P2D2-BKS05.txt
P2D2-BKS06.txt
Zeolites SLC data
P2D2-SLC01.txt
P2D2-SLC02.txt
P2D2-SLC03.txt
P2D2-SLC04.txt

(The four SLC files can be grouped into a single cluster)

GRINSP data
P2D2-GRI01.txt
P2D2-GRI02.txt

(The two GRINSP files can be grouped into a single cluster)

Tetrahedral only (100000 entries each)

Zeolites and frameworks with one sort of polyhedra, ~60000 entries
Structure candidates combining two kinds of polyhedra, titanosilicates,
etc, ~100000 entries

Also, the four SLC and the two GRINP files can be grouped into a single cluster, but
about 1% of the patterns may be remain unindexed. To group the all six BKS files in a
single cluster, it is necessary to limit the scan interval in a specific database setup, so
that this left optimized in function of the experimental conditions in our laboratory (i.e.
limiting d-spacing interval between 70 to 2.5 Angstroms).
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Figure D1. P2D2 database setup. Several files can be grouped into a single database by
checking the ‘Clustering database’ box (see also previous page).
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Figure D2. ‘One Click’ search-math checking with a cluster of P2D2-BKS01, P2D2BKS02 and P2D2-BKS03 files (300 000 entries of P2D2 patterns).

Figure D3. Boolean searching in P2D2. In the example, 9087108 PCOD phase is
displayed by entering their code. ‘PCOD9087108’, ‘9087108’, ‘908’ AND ‘7108’ can be
used indistinctly. SET & FILE are XPowder12 dummy codes for PDF2 compatibility
purposes.
Home
New Quantitative Full-Profile
XPowder12
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New additional method for background
subtraction
Ver XPowder12.02.11
The custom points where the background will be plotted, can now be adjusted by an
cubic spline in addition to classic polynomial fitting.

A) Select custom background points and ‘Option spline’

B) Clink ‘Go’ and select ‘yes’

C) Background correction is done.
XPowder12
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New topics …
Ver XPowder12.02.11

The area under the selected zone is now displayed continuously.

Ver XPowder12.03.03
In version 03.03, direct reading of Bruker RAW patterns has been improved.

XPowder12
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Ver XPowder12.03.04. CRITICAL UPDATE
1. The graphical matching between intensities of the experimental XRD patterns with
those shown in some databases has been improved. Previously appeared some
errors of the intensity scale due to that the 2 scan interval in experimental
diffractograms not includes the database maximum intensity, as occasionally happens
at high 2 angles.

2. The colors of the plots representing diffractogram patterns of databases can now be
modified with the help of the tool as shown in Figure, where the change in color
of the calcite database is illustrated. You can only change the colors of the
checked phases.
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Excluding elements from the periodic table in the search-match.
Very often happen incorrect determinations of crystalline phases, because with those with
frequent chemical compositions appear a large number of phases with unusual
compositions, but whose number is very large within the content of the databases. The
problem is aggravated when the structures allow solid solutions, or when the number of
phases is large.
A partial solution to this problem is to remove those elements which are not expected in
the sample composition from the periodic table. This possibility has been introduced in the
program, using a tool which is accessible using the button ‘Periodic Table Edition Mode’
(Fig E1).

Fig E1.
Fig E2.

By clicking the ‘Periodic Table Edition Mode’

button, you access the tool of

Fig E2. Individual elements can be ruled out (by clicking on the box the item as in
Figure E3) or sequentially clustered (Figure E4).

Fig E3. When it is Click on in the box of an item, it is discarded and then its symbol
is written in white as Tc (Z=43) in picture.
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Fig E4. Pressing the shift key, clicking the first (‘Np’ , Z= 93 in the picture) and last
(‘No’, Z= 102 in picture), and finally releasing the shift key, the intermediate elements
(93 ≤ Z ≤ 102 )are discarded .

Fig E5. Also possible to use custom groupings presets. To do this just click on any of
the buttons beneath the header ‘Call’.

Fig E6. Any

‘Restore’ buttons reset all elements of the periodic table.
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Fig E7. After exclusion of undesired elements, you can save your settings by clicking on
any text box beneath the header ‘Rename preset’.

Fig E8. A double click on the text box, or simply click on the button ( ‘My elements’
in the example), save the preset.

Fig E9. A click on the ‘Exit PT Edition Mode’ button in Fig E8, leaves the ‘edit mode’
of the periodic system. Boolean operations can now be used on the remaining elements
only. Discarded Elements are recorded in the "Elements.Log" file and Presets in the
"Preset.Log" file. Both files are charged by the program every time it reboots and does not
change unless you delete them manually, or are edited again with the tools shown above.
Home
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Ver XPowder12.04.35. CRITICAL UPDATE


The calculated d-spacing reflections in the current diffractogram can be saved and
retrieved later or in subsequent sessions.
From the main menu use File/ Preserve(Recover) d-spacings.



It has been rewritten completely the LS and SA routines for quantitative using
database records based analysis. This does not change the results obtained in
previous XPowder12 versions, but the appropriate values of R-factor will now get
almost automatically. The calculation parameters that can be modified now are 2
zero shift correction (1), virtual background subtraction correction (2) and
statistical weighing experimental counts (3). It has removed the option of tuning of
d-spacing database records because misuse of this option may cause mathematical
artifice erroneous results, even even when R-factor values are low.
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